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ABSTRACT 

Rosalia Mega Artikarini. 2024. A Comparative Study Between The Implementation 

of Storytelling Method and Reporting Method in Teaching Speaking at the Eighth 

Grade of MTs N 06 Boyolali in the Academic Year of 2023/2024. Thesis. English 

Language Education, Cultures and Languages Faculty. 

This research aimed to examine (1) the significant difference between 

students who are taught using the storytelling method and those who are taught 

using another method and (2) whether the storytelling method is effective in 

teaching speaking. 

This research used a quantitative approach with an experimental method. 

The researcher used an experimental design. The population was all the eighth-

grade students in MTs N 06 Boyolali in the academic year of 2023/2024. The 

experimental class students were taught using the storytelling method, and those in 

the control class were taught using the reporting method. The researcher used 

cluster random sampling to determine the subject of the research. The researcher 

took 64 students from a total of 287 students as the sample. The researcher used 

pre-test and post-test to collect the data. To analyze the data, the researcher used a 

t-test using SPSS.  

The results of the research showed that the students who were taught using 

the storytelling method had higher scores in teaching speaking than the students 

who were taught by using the reporting method. Furthermore, the research showed 

the mean of students' post-test for the experimental class is 77.66, and for the control 

class, it is 75.47. It showed that there was a significant difference between the 

students who were taught using the storytelling method and those who were taught 

by using the reporting method. The result of the t-test showed that Sig.(2-tailed) 

0.039 is lower than 0.05. Based on the explanation above, the researcher concludes 

that using the storytelling method is effective in teaching speaking. 

Keywords: Storytelling, Teaching Speaking, Experimental. 
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CHAPTER I 

INTRODUCTION  

A. Background of the Study 

Language is a social communication tool in the form of a system of 

sound symbols produced from human speech. Language is the ability 

possessed by humans to communicate with other humans. Jeans Aitchison 

(2008: 21) "Language is a patterned system of changing sound signals, 

characterized by structural dependence, creativity, displacement, duality, 

and cultural transmission." Language is a system formed from agreed-upon 

sound signals marked with interdependent structures, creativity, placement, 

duality, and cultural spread. Therefore, language is essential for every 

human being to own and master. 

Teaching is the process of conveying or transferring knowledge from 

an educator to students. Hasibuan, J.J., and Moedjiono (2012) revealed that 

teaching creates an environmental system that allows learning. This 

environmental system consists of components that influence each other: 

goals, teaching materials, teachers, students, methods, and facilities and 

infrastructure. According to Maswan and Khoirul Muslimin (2011: 219), 

teaching is giving lessons to someone (students) by training and giving 

instructions so that they gain a certain amount of experience. Therefore, 

teaching is a process carried out by educators to achieve learning goals. 

Storytelling is an activity to convey a story. Storytelling allows 

students to internalize essential aspects of a story’s beginning and ending, 
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setting, characters, and storyline. Farrell and Nessel (Isbell et al. 2004) 

explain that storytelling helps develop fluency, increases vocabulary, and 

helps remember words. Morrow in Tompkins (2005:15) states that 

storytelling can provide pleasure and stimulate children's imagination. Apart 

from that, Marrow believes that storytelling is one way to develop English-

speaking skills. Therefore, storytelling activities provide practice in 

expressing ideas in the unit's mind, using colorful and descriptive language, 

developing ideas sequentially, and choosing effective action words.  

Based on pre-research conducted by the researcher at MTs N 06 

Boyolali on Thursday, 07 September, and Friday, 08 September 2023, the 

researcher found problems in learning English, especially speaking 

problems. The problem the researcher found was the need for more 

vocabulary possessed by students, so students found it difficult to pronounce 

English. The second problem is the need for more ability in pronunciation 

when they speak English. Students also lack self-confidence and even fear 

when the teacher gives orders to talk in front of the class. Thus, to teach 

speaking in English subjects at MTs N 06 Boyolali, the researcher found the 

method used by English teachers in teaching speaking, namely by using a 

method in the form of the Reporting Method. The Reporting Method is a 

method of reading the news carried out by students, and then the students 

explain it again in front of the class. The teacher does this to increase 

students' self-confidence, improve their pronunciation skills, and increase 

their English vocabulary. 
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Based on this explanation, the researcher chose MTs N 06 Boyolali 

because the problems found by the researcher at MTs N 06 Boyolali were in 

accordance with the researcher's topic. The next reason the researcher chose 

MTs N 06 Boyolali was because this school was sufficient criteria for the 

researcher to take samples. 

Several a researcher have explored the effectiveness of storytelling 

in teaching speaking. Adela Febrina's study (2021) “Penerapan Metode 

Storytelling Untuk Meningkatkan Percaya Diri dan Kemampuan Berbicara 

Siswa”. The research results found that the storytelling method had a 

positive impact that could help students with problems in their English 

speaking skills at SMA Negeri 1 Pagar Alam.  

Apart from that, Sigit Widiyanto, et al. (2023) “Efektivitas Story 

Telling dalam Pembelajaran Bahasa Inggris Di SD Negeri 6 Kota Bekasi”. 

Result of the researchers found the storytelling method was effective for 

application in the English speaking class at SD Negeri 06 Bekasi City. 

Therefore, researchers will look more closely at the storytelling method in 

teaching speaking. 

Based on the explanation above, novelty can be found in this 

research, such as the novelty of the subject that the researcher used. In 

previous research, the subjects usually used were elementary school level 

and high school level. However, in this research, the novelty of this research 

is that the researcher used subjects at the junior high school level. Then, 

novelty in this research was found in the methods carried out by previous 
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research, mostly found using classroom action methods with data collection 

techniques using interviews and oral tests. However, the researcher used a 

quasi-experimental method with data collection techniques: try-out, pre-

test, and post-test in this research. 

Based on the problem that the researcher raised from the school 

where the research researcher was riset, it was students' lack of vocabulary 

and pronunciation skills in speaking English, so students found it difficult 

to speak English in class. Therefore, the researcher used the Storytelling 

method to adjust this problem at MTs N 06 Boyolali. Thus,   a researcher 

should consider the storytelling method in teaching speaking at MTs N 06 

Boyolali. 

Based on the description above, the researcher focus in this thesis is 

the storytelling method in teaching speaking to students. The researcher 

conducted research at the eighth grade of MTs N 06 Boyolali. Therefore, by 

considering several descriptions and problems, the researcher conducted 

research entitled "A Comparative Study Between the Implementation of 

Story Telling Method and Reporting Method in Teaching Speaking at 

the Eighth Grade of MTs N 06 Boyolali in the Academic Year of 

2023/2024". 
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B. Identification of the Problem 

Based on the explanation of the research background above, problem 

identification can be used as follows: 

1. Some students at MTs N 06 Boyolali have difficulty speaking English 

2. Some students at MTs N 06 Boyolali have difficulty in pronunciation 

when speaking English  

3. Some students at MTs N 06 Boyolali are able to speak English, but their 

vocabulary is still limited 

4. Some students at MTs N 06 Boyolali lack confidence when speaking 

English in front of the class 

5. Some students at MTs N 06 Boyolali feel afraid when speaking English 

in front of the class 

C. Limitation of the Problem 

To focus attention on the topic, researcher limit both the object and 

subject of their research. The researcher bases the object on only two 

variables. The storytelling method is the independent variable and teaching 

speaking is the dependent variable. The researcher conducted research on 

teaching speaking to students in eighth grade at MTs N 06 Boyolali in the 

2023/2024 academic year. The research will focus on the method that 

researcher will use in teaching speaking, namely by using the Storytelling 

Method with Describe Yourself material. Apart from that, the comparison 

method in this research was carried out by the English class teacher at MTs 
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N 06 Boyolali using the Reporting Method with the same material, namely 

Descriptions Text. 

D. Formulation of the Problem 

To make it easier to carry out this research, it is necessary to 

formulate questions such as;  

1. Is there any significant difference between students who are taught using 

the story telling method and those who are taught using another method 

at eighth grade of MTs N 06 Boyolali in the academic year of 2023/2024? 

2. Which method is more effective between storytelling method and 

reporting method in teaching speaking to the eighth grade of MTs N 06 

Boyolali in the academic year of 2023/2024? 

E. Objective of the Study  

Based on the formulation of the problem above, the objectives of this 

research can be listed as follows: 

1. To find out the any significant difference between students who are 

taught using the story telling method and those who are taught using 

another method at eighth grade of MTs N 06 Boyolali in the academic 

year of 2023/2024. 

2. To find out whether the effectiveness level of storytelling method and 

reporting method in teaching speaking to eighth grade of MTs N 06 

Boyolali in the academic year of 2023/2024. 
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F. Benefits of the Study  

This study is expected to produce results that will be beneficial to 

the advancement of the English teaching-learning process. The following 

are some expected benefits of the study: 

1. Students  

For students, this research will be useful to know their learning 

methods and increase their confidence to improve their speaking skills as 

well. 

2. Teacher  

For teachers, this research will be useful to find out how learning 

methods have a significant influence on learning to speak English 

3. Researcher  

For future researchers, this research will be useful as a reference 

for further research that focuses on student learning methods in teaching 

speaking 

G. Definition of the Key Terms 

In order to explain and avoid misunderstandings and 

misinterpretations regarding the title and content of the research, it is useful 

to define the terms used in this research as follows: 

1. Experimental 

An experiment is research that is intend to determine whether 

there is an effect of something imposed on a subject by comparing one 

or more experimental groups that are give treatment with one or more 
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comparison groups that do not receive treatment. According to Sugiyono 

(2012: 107), experimental research can be interprete as a researcher 

method used to find the effect of certaed treatments on others under 

controlled conditions. 

2. Teaching Speaking  

Teaching speaking in English classes is a process carried out by 

educators to achieve learning goals. In achieving learning goals, 

educators need a teaching method to convey learning that is easily 

accepted by students in order to achieve learning indicators. Kayi 

(2006:1) teaching speaking is teaching English language learners to 

produce English sound and pronunciation patterns, use word and 

sentence stress, intonation patterns and second language rhythm, choose 

appropriate words and subject matter, and organize their thoughts in 

sequence. That is meaningful and reasonable, uses English as a tool to 

express values and judgments, and uses English quickly and confidently 

with few unnatural pauses called fluency. 

3. Story Telling Method 

The story telling method was developed as an interactive 

approach between students, teachers and learning materials. Through the 

story telling method, students are stimulated to develop thinking and 

imagination skills so that students are encouraged to learn. Telling stories 

can develop students' potential language skills through listening and then 

telling them again with the aim of training students' conversation skills 
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to convey ideas in oral form (Milana, 2021; Qurbani & Oktrima, 2019; 

Salim, 2019). 

4. Reporting  

Oxford (1990) defines a report as giving a spoken or written 

account of something that one has observed, heard, done, or investigated. 

The reporting method is usually used for learning in terms of reporting 

news. The role of the Reporting Method in student speaking is very 

effective in developing creativity. 
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CHAPTER II 

LITERATURE REVIEW 

A. Theoretical Review 

1. Review on Teaching Speaking  

Fauziati (2010: 15) stated that teaching speaking should be 

considered central in foreign language pedagogy. Fauziati also added 

that the goal of teaching speaking skills is communicative efficiency. 

This means that learners should be able to understand themselves fully 

using their current proficiency. Fuziati (2010: 16) also added that 

teaching a foreign language is no longer accepted when focusing only 

on form since meaning is paramount. She also said that foreign language 

teaching aims to develop communicative competence; both a focus on 

form accuracy and meaning (fluency) should be balanced so that the 

learners can use language naturally. According to Nunan (2003), what is 

meant by “teaching speaking” is to teach ESL (English Second 

Language) learners to: Produce the English speech sounds and sound 

patters; first use word and sentence stress, intonation patterns and the 

rhythm of the second language. Second elect appropriate words and 

sentences according to the proper social setting, audiences, situation and 

subject metter. Third, organize their thoughts in a meaningful and logical 

sequence. Fourt, use langauge as a means of  expressing value and 

judgement. Last, use the language quickly and confidently with few 

unnatural pauses, which are called as fluency 
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In language teaching, especially speaking, the teacher helps the 

students develop their knowledge by providing authentic practice that 

prepares students for real-life communication situations. The students 

are allowed to develop their ability to produce grammatically correct, 

logically connected sentences appropriate to specific contexts and to use 

acceptable pronunciation. 

According to the experts above, the researcher concludes that 

teaching speaking is the way to teach English language learners and the 

way to develop the learner’s ability to speak. Learners should be able to 

make themselves understood and use the language quickly and 

confidently with few unnatural pauses. 

a. Definition of Speaking  

  Speaking is defined operationally as a language student's 

ability to speak English appropriately in specific, meaningful 

contexts to serve transactional and interactional purposes using 

correct pronunciation and grammar. Spratt et al. (2005) define 

speaking as a productive skill. It involves the use of speech to 

express meaning to others. Nunan (2003) agrees with Spratt et al. 

that speaking is a practical oral skill that produces systematic verbal 

utterances to convey meaning. Brown (2004) also added that 

speaking is a productive skill in the organs of speech to express the 

sense that can be observed directly and empirically.  
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Regarding speaking ability, Nunan (2003) states that 

speaking ability is the speaker's ability to convey information, 

express ideas, thoughts, feelings, and reactions to inappropriate 

structures, speech sounds and sound patterns, and vocabulary that is 

appropriate to the situation and language subject and use language 

quickly and confidently. Ability can be performed well because it 

has been studied and trained. Brown (2004: 406-407) says that 

speaking ability has five components: grammar, vocabulary, fluency, 

comprehension, and pronunciation. 

Fulcher (2003) states that speaking is using verbal language 

to communicate with other people. According to Adam (2005:78), 

speaking is an oral communication between two or more people to 

express the idea of talking together. Haryadi and Zamzani (2000:72) 

argue that, in general, speaking can be interpreted as conveying one's 

intentions (beliefs, thoughts, feelings) to others by using spoken 

language so that others can understand its meaning.  

This understanding has the same meaning as the two 

opinions that have been described previously, only that it is clarified 

with a further purpose, namely so that what is conveyed can be 

understood by others. At the same time, St. Y. Slamet and Amir 

(1996: 64) put forward the notion of speaking as a skill to convey 

messages through spoken language as an activity to convey ideas 

compiled and developed according to listeners' needs. This 
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definition explains that talking is not just saying words but more 

emphasis on communicating ideas collected and developed with the 

requirements of listeners or recipients of information or opinions. 

Pollard (2008:33) says that speaking is one of the most 

challenging skills for students to master. It is not surprising that one 

considers the things involved in speaking: ideas, what to say, 

language, how to use grammar and vocabulary, pronunciation, and 

listening and reacting to the people you are communicating with. 

That is why speaking is one of the most essential language skills for 

students to master to become good communicators (Brown, 2001). 

The ability to use language as a communication tool often indicates 

success in speaking. Bailey and Nunan (2005) argue that speaking is 

an essential aspect of language learning, both as a second language 

and as a foreign language, which can be measured by students' 

ability in the learning process. 

Based on the explanation above, speaking can be a way for 

someone to describe something with oral communication as an 

activity. Speaking is also used for many different purposes, and each 

goal involves other skills like expressing our ideas, clarifying 

information, and persuading someone or something. In addition, 

speaking is essential in expressing thoughts, opinions, or feelings to 

others. Speaking also plays a critical role in life because all life 

activities are carried out by communication. People can establish 



14 
 

 
 

relationships, inform, share, and seek information through touch. In 

other words, people can do whatever they need through 

communication. In this case, speaking is a skill that students need to 

convey their ideas so that they are easy to communicate. 

b. Components of Speaking  

According to Brown (2004: 172-173), there are five 

components in speaking skills they are grammar, vocabulary, 

pronunciation, fluency, and understanding. 

1) Grammar 

Grammar is a structured set of rules that govern the 

arrangement of sentences, phrases, and words in any language. 

Thornbury (2002) sees grammar as an explanation of the rules 

for building sentences that convey language meaning. In short, 

grammar is language rules that allow someone to put together 

sentences to obtain meaning in language. Therefore, mastering 

grammar will help someone speaking English because students 

will know how to arrange words in sentences, what tense to use, 

and how to use correct speech. In other words, grammar plays 

an important role in mastering spoken language. 

2) Vocabulary  

Vocabulary is a collection of words owned by a person from 

a particular language. A person's Vocabulary is defined as the 

collection of all the words that the person understands or all the 
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words that the person is likely to use to construct new sentences. 

According to Linse (2005, p. 121), Vocabulary is a collection of 

words a person knows. Students need to have sufficient 

Vocabulary to communicate. Increasing one's Vocabulary is 

generally considered an essential part of learning a language and 

developing one's abilities in the language one has mastered. 

According to Craff (1998), Vocabulary is classified into two 

types. The first is active Vocabulary, which students use to 

understand their meaning and use them constructively in 

speaking. The second is passive Vocabulary, words that students 

can recognize and understand when used in context. Therefore, 

vocabulary mastery is essential in teaching and learning to 

speak, so language learners must choose specific terms correctly 

to make their conversations meaningful. 

3) Pronunciation 

Pronunciation results from speech production, which 

includes articulation, accent, and vocal formation style. 

Pronunciation is the most critical indicator in determining the 

success of communication. With correct pronunciation, listeners 

will be able to know and understand the meaning of what the 

speaker is conveying. In English, pronunciation is something 

that is a challenge for us Indonesians. English has a very 

different way of pronunciation from Indonesian. Several words 
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in English have specific pronunciation techniques. If correct 

language rules do not follow this pronunciation technique, it can 

cause misperceptions in English communication. Therefore, 

pronunciation has a central role in both academic and social 

fields in how students can participate in their communities or 

organizations. 

4) Fluency  

Fluency is speaking spontaneously and fluently, which can 

cause its implementation to be done well and optimally. Thus, 

fluency can encourage a person's activities to influence the 

achievement of the desired results. So, fluency can be defined as 

the ability to speak fluently and easily. Therefore, the speaker 

must speak fluently so that the listener can respond to what the 

speaker says. 

5) Understanding 

The last element of speaking is understanding. 

Understanding is a person's ability to understand something and 

then know and remember (Sudijono, 2011:50). Comprehension 

means understanding and interpreting what is said. This 

concerns the student's skill in speaking on all professional and 

general topics without significant effort and precisely like a 

native speaker (Arthur Hughes, 2003).In speaking, 

understanding is undoubtedly needed so that the speaker can 
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initiate communication and the listener can respond. 

Understanding is essential to avoid misunderstandings between 

the speaker and listener so that communication can run well. 

In conclusion, pronunciation, grammar, vocabulary, fluency, 

and understanding are essential and complementary components in 

developing students' speaking skills. These elements support each 

other in achieving the purpose of speaking. 

c. Instruments of Speaking  

According to Burhan (2005: 94), several aspects are assessed 

when children speak, including the following: 

1) Pronunciation Accuracy 

When students speak, they must get used to pronouncing 

language sounds correctly. Inappropriate pronunciation of 

language sounds can affect the listener's attention. The speech 

and articulation patterns used are sometimes different because 

each person has their language style, which is used according to 

the subject of discussion. However, if the change is too striking 

and distorted, then the effectiveness of speaking will be 

compromised. 

2) Intonation Accuracy 

Accuracy of intonation is the main attraction in speaking 

and is a determining factor. Even though the problem being 

discussed could be more attractive, using appropriate intonation 
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will make the problem enjoyable. On the other hand, if the 

delivery is flat, then it is certain that the conversation will be less 

effective. 

3) Fluency 

Fluency in speaking makes it easier for listeners to 

understand the content of the conversation. Often, students speak 

disjointedly; even between the disjointed parts, certain sounds 

are inserted that are disturbing to hear, such as ee, oo, aa, and so 

on. On the other hand, if students speak too quickly, it can also 

annoy listeners. 

4) Word Choice (Diction) 

Word choice (diction) must be precise, clear, and varied. 

The apparent meaning is that it is easy to understand by the target 

listener. The listener will understand better if the words used are 

already known to the listener. 

In conclusion, pronunciation accuracy, intonation accuracy, 

fluency, and word choice are essential and complementary 

instruments in developing students' speaking skills. These 

instruments support each other in achieving the purpose of speaking. 

2. Review on Storytelling 

a. Definition of Storytelling 

Storytelling is activities related to telling a story to one or 

more listeners. Storytelling is an activity or activity to convey a 
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story. Malan (1991) said that storytelling is an effort made by the 

storyteller to share feelings, thoughts, or an account with children 

orally. After the development of the times, storytelling has also 

progressed. Therefore, storytelling is not only conveyed verbally but 

storytelling can be conveyed through tools or media so that someone 

can find out about a story by reading. According to Nurbiana et al. 

(2005), storytelling is an activity that someone does orally to another 

person with or without tools about what should be conveyed in the 

form of a message, information, or just a fairy tale that is to be 

listened to with a sense of enjoyment. Therefore, people who 

presented the story told it interestingly. 

 According to Oliver (2008), storytelling is an art that depicts 

actual or fictional events and can be conveyed using images or 

sound, while other sources say that storytelling is a depiction of life, 

which can be in the form of ideas, beliefs, personal experiences, 

learning about life through a story. According to Henny (2007) in 

Mualifah (2013: 99), the storytelling learning process or storytelling 

method is one method for improving speaking skills. Storytelling is 

sharing knowledge about the story's content and experiences and 

providing advice to children. 

The storytelling method is a method that can develop 

children's language skills, especially listening and speaking skills. In 

line with this, storytelling methods can improve language skills and 
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instill morals in children (Pebriana, 2017). This method is a form of 

method that teachers can use to create fun learning following 

learning principles in early childhood education. It is a 

communication tool that can be adapted to the listener's culture 

(Barker & Gower, 2010). 

According to Astiti (2016), the storytelling method is 

activities done orally to other people with tools or without tools 

delivered in the form of messages, information, or just a fairy tale 

listened to with pleasure because the person presenting the story 

conveys it. The storytelling presentation will fill the child's memory 

with various information, including life values and various points of 

view. The event in the story will enrich children's experience to be 

used as reference material for problem-solving or changing 

behavior. 

Storytelling can also encourage children to create 

imagination and fantasy towards the stories he brings so that 

children can do it based on their imagination. When a child's 

imagination is directed towards values and character, it is hoped that 

the child will have a good personality and character. Models or 

examples, besides being given through behavior carried out in real 

terms by parents, teachers, or peers, can also be given through fairy 

tales (JulitaD. et al., R. F 2012). 
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Based on the description above, storytelling is an activity 

that encourages children to imagine the stories they tell so that 

children can create something based on their imagination. 

Storytelling is a means of conveying educational values that are 

packaged excitingly so that the contents of the story can be 

understood. Storytelling can be a motivation for self-awareness and 

self-imagination. 

b. Stages of Storytelling  

According to Geisler (1997), there are three stages in 

storytelling: preparation before the storytelling event begins, during 

the storytelling process, and until the storytelling activity is 

completed. So, to find out more clearly, here is a description of these 

steps: 

1) Opening Activities 

At the start of the activity, the storyteller will attract the 

children's focus with a concentration game, creating a two-way 

contact between the storyteller and the audience because Geisler 

requires eye contact between the storyteller and the audience. 

2) Core Activities 

The next activity is the core activity, namely storytelling. 

The storyteller will present the story by paying attention to 

words, body gestures, and sound play to display a visual image 

in the children's minds as the audience. The story that will be 
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given is one story title that will be given for one day. The 

intensity of sharing stories once a day is related to teachers' 

experience in that child being able to remember just one lesson 

material or theme requires 4 to 6 meetings. Therefore, giving 

stories once a day avoids influence bias other than treatment 

storytelling because children at that age develop very quickly. 

3) Closing  Activities 

The closing activity allows the audience to express their 

opinion verbally regarding the story they have heard, then also 

provide the chance to show it visually on the illustrated paper 

that has been prepared. This activity is an operational aspect of 

Geisler's storytelling theory, namely providing a meaningful 

experience after listening to storytelling. 

During storytelling, several factors can support the 

storytelling process so that it becomes interesting to listen to 

(Asfandiyar, 2007), including: 

a) Eye contact 

When storytelling occurs, the storyteller must make eye 

contact with the audience. Look at the audience and be silent for 

a moment. Making eye contact makes the audience feel they are 

being cared for and invited to interact. Apart from that, we can 

see whether the audience is listening to the story by making eye 
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contact. That way, the storyteller can know the reaction of the 

audience. 

b) Facial expressions 

When storytelling occurs, the storyteller's facial 

expressions can support whether the story is alive or not. The 

storyteller must be able to express his face according to the 

situation being told. To show facial expressions depicting a 

character's feelings takes work. 

c) Body movements 

The storyteller's movements during the storytelling process 

can help depict a more exciting storyline. The story being told 

will feel different if the storyteller makes movements that reflect 

what the characters in the story are doing. It is different if the 

storyteller only tells the story in a static position from beginning 

to end. The story will feel boring, and ultimately, the audience 

will no longer be enthusiastic about listening to the story. 

d) Sound 

The storyteller can use the high and low levels of the voice 

to make the child feel the situation of the story they are listening 

to. The storyteller will usually raise his voice intonation to reflect 

a tense story. Then, lower it to a flat position when the story 

returns to its original situation. Professional storytellers can 
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convey the voices of the characters being told. For example, the 

sound of a volcano erupting, the ground collapsing. 

e) Speed 

The storyteller must be able to regulate the speed or tempo 

of storytelling. Keep your speaking speed at the same or steady 

pace. The story told is not too fast so that children become 

confused or too slow so that children become bored. Applying 

the storytelling method for children aged 5-6 years, the time to 

tell the story is around 10-15 minutes (Erlia, 2014). However, in 

this case, the storytelling process is carried out for ± 30 minutes 

with breaks every ± 10 minutes. 

f) Props 

To attract children's interest in the storytelling process, 

props such as tiny dolls are worn in the hands to represent the 

characters being used as fairy tale material. Other props that can 

be used include dolls, puppets, clothes, pictures, or drawings. 

Storytelling using props can make the story more fascinating 

because children can immediately see the visual form of the 

story. 

Based on the explanation above, it can be concluded that the 

storytelling method has several stages. Besides that, in conveying a 

story or telling a story, there are factors to support the process of 

telling the story so that the listener feels happy. 
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c. Strengths and Weaknesess of Storytelling 

According to Ulfah Trijayanti et al. (2017), there are 

advantages and disadvantages to this storytelling method, including 

the following: 

Table 2.1 Strengths and Weaknesses of Storytelling 

Strengths  Weaknesses  

Stories can activate and arouse 

children's enthusiasm. Because 

children will always reflect on 

the meaning and follow various 

story situations, students are 

influenced by the characters 

and topics of the story. 

Children's understanding will 

become problematic when 

other problems have 

accumulated in the story. 

Direct all emotions so that they 

converge on one conclusion at 

the end of the story. 

It is a monologue and can bore 

students. 

Stories are always captivating 

because they invite you to 

follow the events and reflect on 

their meaning. 

There is often an inconsistency 

between the story's content and 

the intended context, so 

achieving the goal takes time. 

Storytelling can affect 

emotions. Such as fear, the 

feeling of being watched, 

willing, happy, resentful, or 

hated until it is turbulent in the 

folds of the story 

 

Storytelling can develop a good 

speaking style. 

When seasoned with a story, it 

will be able to increase its 

memorization, where there is a 

new depiction of life, especially 

adding the value of art in its 

carrying so that a listener 

enjoys and appreciates it. 

 

 

Based on the explanation above, the storytelling method has 

weaknesses in the learning process. However, it can also be seen that the 
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storytelling method has several strengths to be used in the learning 

process. 

3. Review on Reporting Method 

a. Definition of Reporting Method 

The role of reporting in students' speaking development 

effectively simulates students' creativity in learning English. 

Reporting in learning is easy to implement in EFL classes, as well 

as in the form of infographics. In addition, Kayi Hayriye (2006), 

argues that there are many ways to improve students' speaking skills. 

One of the most effective ways is the reporting method. The 

reporting method is to arrange the words of information that has 

been seen in oral form so that it can be reported to the listener as new 

information in a unique style.  

Betty Shrimper Azar (1993), states in Understanding English 

Grammar, "Reported speech refers to using noun clauses to report 

what someone said." Reported speech (indirect speech) is used to 

communicate what another person has said but without exact words. 

There are two broad categories of reporting methods: written 

methods, such as fact sheets, and oral/visual methods, such as 

(PowerPoint presentations, exhibits, news releases, etc.).  

Whatever method is used, the report must consider the 

audience and be accessible and understandable, especially by 

students. Many students can practice in front of the class to explain 
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the information they have obtained so that students will gain a lot of 

knowledge from the reporting methods accepted. 

From the definitions above, we can conclude that the 

reporting method is a way of quoting someone's ideas or thoughts 

by repeating the exact same words or information produced by the 

speaker. So, in using the reporting method, students read information 

or other knowledge through specific sources and then repeat the 

contents of the ideas in that information in front of the class as a 

form of learning method to speak English. 

b. Stages of Reporting Method 

According to Mr.A, as an English teacher at MTs N 06 

Boyolali year (2022), in using a reporting method so that it can be 

structured, it is necessary to have procedures for carrying out the 

reporting method; 

1) Analysis of an Object 

The first way to carry out the reporting method is that 

students are asked to analyze news, stories, or pictures given by 

the teacher. By analyzing the report, students can develop 

imagination and creativity in learning. Besides that, by analyzing 

information, students can increase their concentration in learning 

through the critical thinking stage. Then, the students explore the 

news content, the results of which are retold in front of the class 

so that all the children in the class understand the news content. 
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2) Describe the Contents of the Object 

The next step is that after students have analyzed the 

meaning of the news, stories, or pictures given by the teacher, 

students are asked to explain or rewrite the meaning of the news. 

This can train students' concentration in reading and writing 

English. 

3) Presentation of the Results of the Analysis of the Idea 

The final step is that after students have written the contents 

of the news, stories, or pictures given by the teacher, students are 

asked to present the results obtained from analyzing an object 

through specific sources. This can have a good impact on 

students' speaking abilities, so the class teacher can control 

students' English speaking skills through this process. Apart 

from that, speaking in front of the class can increase students' 

self-confidence and overcome students' fear of being in front of 

many people. 

Based on the explanation above, the reporting method is a 

method where students observe a particular object and then explain 

it again to the students in front of the class. 

c. Strengths and Weaknesess of Reporting Method 

According to Mr.A, as an English teacher at MTs N 06 

Boyolali year (2022), Reporting has several strengths and 



29 
 

 
 

weaknesses. The following strengths and weaknesses of the 

Reporting method are presented below: 

Table 2.2 Strengths and Weaknesses of Reporting 

Strengths Weaknesses 

The reporting method can make 

students think critically, which 

serves to improve their ability 

to analyze. 

Not all stories, news, or images 

reported can be understood by 

students who listen 

 

The reporting method can train 

students' understanding by of 

reading the content of news, 

stories, or pictures provided by 

the teacher. 

Students feel bored listening 

when the report is delivered 

monotonously 

 

The reporting method can make 

students interested in listening 

to the content presented. 

 

 

Based on the explanation above, the reporting method has 

weaknesses and strengths, so it can be used as a teaching method by 

emphasizing its strengths. 

B. Previous Related Study 

The researcher found some research reports relevant to the problems 

that are discussed in this research. First, a study from Sri Endang Ratnasari 

(2023) with Volume 8 number 1, entitled “The Effectiveness of Using 

Digital Storytelling Video in Teaching Speaking at SMK Telkom 

Banjarbaru”. This research examines whether using digital storytelling 

videos is beneficial or not in improving students' verbal communication. 

The researcher used a research method in the form of purposive sampling. 

This research uses a pre-experimental methodology with a design consisting 
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of one group for the pre-test and post-test. The results obtained by 

researchers show that digital storytelling videos can improve students' 

speaking skills in terms of fluency.  

Second, research from Andi ST Aldilah Khaerana and Nadya 

Nurhidayah Nurdin with volume 4, number 02 of 2018, with the research 

title “The Effectiveness of Story Telling and Story Reading Methods in 

Teaching Speaking at STKIP YPUP Makassar”. The researcher applied a 

comparative study method, which aims to determine the comparison 

effectiveness of between storytelling and story reading methods in teaching 

speaking skills. Researchers used an experimental design involving two 

groups. The results obtained from this research show that there is no more 

effective method between telling stories and reading stories in teaching 

speaking. However, for the speaking category, speaking methods can 

improve students' fluency in speaking. Meanwhile, the story-reading 

method can improve students' understanding.  

Third, Hairi Yanto in 2018 with the title “The Effect of Storytelling 

Technique Towards Students' Speaking Ability at Class XI of State Islamic 

Senior High School MAN Salido”. The purpose of this research is to 

determine whether storytelling techniques have a significant influence on 

students' speaking abilities and to determine the components of speaking 

skills that are improved by the application of storytelling techniques on 

students' speaking abilities, such as vocabulary, pronunciation, grammar, 

fluency, and comprehension. This research is experimental research using a 
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quantitative approach. The sampling technique in this research used random 

sampling. The results obtained from this research show that the storytelling 

technique significantly influences students' speaking abilities. The speaking 

component that can be improved through the storytelling method is 

pronunciation.  

Fourth, Andi Idayani in 2019 with the title "The Effectiveness of 

Digital Storytelling on Students' Speaking Ability at FKIP-Islamic 

University of Riau. The purpose of the research is to determine if digital 

storytelling has a significant effect on students' speaking ability. Then, 

describe and analyze digital storytelling's effectiveness in enhancing 

students' speaking ability. In this study, the researcher used experimental 

research. A practical usually involves two groups of subjects: an 

experimental group and a control group. The population of this research was 

the fifth-semester English students of FKIP - Islamic University of Riau in 

the academic year 2018/2019. The sampling technique used in this research 

is purposive sampling. The results obtained from this research show that 

digital storytelling positively influences students' speaking skills, especially 

in the field of English studies. 

Fifth, Andi Iswatun Hasanah; Murni Mahmud, Kisman Salija with 

Vol. 2, no. 5, of 2022 with the title "The Implementation of Storytelling 

Method to Improve Students' Speaking Achievement at Second Grade 

Students of MA Belang-Belang Maros". This research used quasi-

experimental research with quantitative and qualitative methods (mixed-
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method). The population of this research was the second-grade students at 

MA Belang-Belang Maros. There were 25 students in the experimental 

group and 25 in the control group. The research sample was taken by using 

the cluster sampling technique in the quantitative method and purposive 

sampling in the qualitative method. This research data was obtained using a 

speaking test, questionnaire, and interview. The results obtained in this 

research show that the storytelling method makes students comfortable and 

confident in participating in English learning. Thus, the researcher stated 

that the storytelling method positively impacted improving students' 

speaking skills. 

Based on several journals that the researcher has found, the 

storytelling method can have a good/positive influence in teaching 

speaking, especially in English subjects. Therefore, this research is 

necessary because it positively impacts students' speaking skills. 

Table 2.3 

Previous Related Study 

Number Researcher Similarity Different 

1.  Sri Endang Ratnasari 

(2023).  

 

The Effectiveness of 

Using Digital 

Storytelling Video in 

Teaching Speaking at 

SMK Telkom 

Banjarbaru. 

➢ This research 

uses a 

quantitative 

approach. 

➢ This research 

uses a type of 

pre-

experimental 

research. 

➢ Location in 

this study at 

SMK Telkom 

BanjarBaru. 

 

2.  Andi ST Aldilah 

Khaerana and Nadya 

➢ This research 

uses a 

➢ Location in 

this study at 
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Nurhidayah Nurdin 

(2018). 

 

The Effectiveness of 

Story Telling and Story 

Reading Methods in 

Teaching Speaking at 

STKIP YPUP Makassar. 

quantitative 

approach. 

➢ This research 

uses a type of 

experimental 

research 

STKIP YPUP 

Makassar. 

3.  Hairi Yanto (2018).  

 

The Effect of 

Storytelling Technique 

Towards Students' 

Speaking Ability at 

Class XI of State Islamic 

Senior High School 

MAN Salido. 

➢ This research 

uses a 

quantitative 

approach. 

➢ This research 

uses a type of 

experimental 

research. 

➢ The sampling 

technique in 

this research 

used random 

sampling. 

 

➢ Location in 

this study at 

Class XI of 

State Islamic 

Senior High 

School MAN 

Salido. 

4.  Andi Idayani (2019) 

 

The Effectiveness of 

Digital Storyteling on 

Students’ Speaking 

Ability at FKIP-Islamic 

University of Riau. 

➢ This research 

uses a 

quantitative 

approach. 

➢ This research 

uses a type of 

experimental 

research. 

 

➢ Location in 

this study at 

FKIP-Islamic 

University of 

Riau.. 

5.  Andi Iswatun Hasanah; 

Murni Mahmud, Kisman 

Salija (2022) 

 

The Implementation of 

Storytelling Method to 

Improve Students’s 

Speaking Achievement 

at Secod Grade Students 

of MA Belang-Belang 

Maros. 

➢ This study 

uses a type of 

quasi-

experimental 

research. 

➢ The sampling 

technique in 

this research 

used purposive 

sampling in 

Qualitative 

and cluster 

sumpling in 

Quantitative. 

 

➢ This study 

uses a 

quantitative 

and 

qualitative 

method 

(mixed 

method) 

➢ This study 

uses a type of 

quasi-

experimental 

research. 

➢ The sampling 

technique in 
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this research 

used 

purposive 

sampling in 

Qualitative 

and cluster 

sumpling in 

Quantitative. 

➢ Location in 

this study at 

secod grade 

students of 

MA Belang  - 

Belang Maros. 

 

 

C. Rationale 

1. The Significant Differences Between Students who are Taught Using by 

Story Telling Method with Those who are Taught Using Another 

Method in Teaching Speaking at the Eighth Grade  of MTs N 06 Boyolali 

in the Academic Year of 2023/2024  

Nurmiyati Nurmiyati and Pujiati Suyata (2014) said that there 

were significant differences among students between Paired Storytelling 

and Conventional techniques in English speaking competency with 

narrative text types. Mulya Burhan (2019) said there is a significant 

influence on parenting patterns and stories about communicating in 

English. According to Hardiyanti Rahmah and Hikmatu Ruwaida 

(2020), the method of Storytelling is very significant in students' English 

speaking skills. The results of research examining the influence of 

Storytelling on children's storytelling abilities and empathy experienced 

significant changes (Dheasari, 2020). Likewise, Lisenbee & Ford (2018) 
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explained that learning experiences with students in The Pittsburgh 

Public School District using storytelling methods that are adapted to 

children's characteristics can provide motivation and performance for 

students who have deficiencies in mathematics, reading, and writing 

skills. Telling stories can teach students to listen to their language skills, 

deepen the features in the story, and broaden their understanding. 

Kurniawati, Tirtayani, & Darsana (2018) explained that telling stories 

helps develop fluency, increases vocabulary, and helps remember words. 

Hidayat D.B. et al. (2020), in their research, found that with the 

storytelling method, there were significant changes in students' speaking 

skills and reading skills. Children's speaking and reading skills change 

significantly. The average before the storytelling method was applied 

was lower than the average after the storytelling method was used. 

Based on the theories above, Storytelling is a method of telling 

stories that involve students' creativity and imagination so that with this 

method, students can think more broadly. Therefore, the researcher can 

conclude that the storytelling method is assumed to be different from 

another method, namely the Reporting method, a speaking learning 

method for Eighth Grade Students at M.T.s N 06 Boyolali in the 

2023/2024 Academic Year. 
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2. The Effectiveness Level of Storytelling Method and Reporting Method 

in Teaching Speaking at the Eighth Grade of MTs N 06 Boyolali in the 

Academic Year of 2023/2024 

Nurmiyati Nurmiyati and Pujiati Suyata (2014) stated that pair 

storytelling is the most effective method for English-speaking 

competency in narrative text types. Tamala (2019) and Pratiwi (2016) 

argue that Storytelling is one of the most effective ways to achieve the 

goals of learning students' speaking skills in class. With this method, the 

class atmosphere becomes more fun and lively. So, it is not surprising 

that it is revealed that Storytelling is a comprehensive concept that 

breaks down the boundaries between formal and informal learning in 

socio-cultural studies. Putri, F.S., and Chotimah, IC (2018), in their 

research, show that Collaborative Storytelling games are effective when 

used to teach speaking skills. David Budi Hidayat et al. (2020) found 

that the use of the method (Storytelling) was effective in children's 

speaking skills and reading skills.  

Based on several theories above, the storytelling method is 

effective because the storytelling method has a good impact on learning. 

With the storytelling method, students can practice their imagination and 

creative thinking skills when telling stories in front of the class. The 

researcher also believe and strongly agree that Storytelling is an 

effective learning platform for teaching speaking at the Eighth Grade 

Students of MTs N 06 Boyolali for the 2023/2024 Academic Year. 
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D. Hypothesis  

Creswell (2012) defines hypothesis are statements in quantitative 

research in which the investigator makes a prediction or a conjecture about 

the outcome of a relationship among attributes or characteristics. The 

hypothesis of the study as a follow: 

1. Hypothesis of the Significant Differences Between Students who are 

Taught Using by Story Telling Method with Those who are Taught 

Using Another Method in Teaching Speaking at the Eighth Grade of 

MTs N 06 Boyolali in the Academic Year of 2023/2024 

a. Ha1 (Alternative Hypothesis1) : There is significant differences 

between students who are taught by Storytelling method with those 

who are taught by using another method in teaching speaking at the 

eighth grade students of MTs N 06 Boyolali in the academic year of 

2023/2024. 

b. Ho1 (Null Hypothesis1) : There is not significant differences between 

students who are taught by Storytelling method with those who are 

taught by using another method in teaching speaking at the eighth 

grade students of MTs N 06 Boyolali in the academic year of 

2023/2024. 
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2. Hypothesis of the Effectiveness Level of Storytelling Method and 

Reporting Method in Teaching Speaking at the Eighth Grade of MTs N 

06 Boyolali in the Academic Year of 2023/2024 

a. Ha2 (Alternative Hypothesis2) : Using Story Telling Method is 

effective in teaching speaking at the eighth grade students of MTs N 

06 Boyolali in the academic year of 2023/2024. 

b. Ho2 (Null Hypothesis2) : Using Story Telling Method is not effective 

in teaching speaking at the eighth grade students of MTs N 06 

Boyolali in the academic year of 2023/2024. 
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CHAPTER III 

RESEARCH METHODOLOGY 

A. Research Design 

In this research, the researcher used a quantitative approach. 

According to Creswell (2012: 13), quantitative analysis requires the 

researcher to explain how variables influence other variables. This research 

is a type of experimental research. According to Sugiyono (2011:7), a study 

with an experimental approach attempts to find the influence of certain 

variables on other variables under strictly controlled conditions. The same 

thing was also expressed by Creswell (2012: 295), that experimental design 

is used when you want to determine the possible causes and influence of the 

independent and dependent variables. According to Sugiyono (2017:18), 

there are several kinds of experimental research: pre-experimental design, 

true experimental design, factorial design, and quasi-experimental design.  

Specially in this study, the research used a Quasi-experimental 

design with pre-test and post-test control group design. In this research, 

there are two designs as samples, namely the experimental group used by 

the researcher in this research using storytelling. Then, the class teacher uses 

the control group using the reporting method. The pre-test is given before 

the treatment is carried out, while the post-test is given after the treatment. 

The following is a description of this study's pre-test and post-test control 

group design. 
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Table 3.1 Design of Research 

E :  O1          X        O2 

C :  O1           Y        O2 

 

E : Experimental group 

C : Control group 

X : Treatment in experimental group 

Y : Treatment in control group 

O1 : Pre-test 

 O2 : Post-test 

  Both group are from the same level. The material taught and the time 

allocation will be same. The different only lies in the method given. The 

experimental group will be taught using Storytelling method while the 

control group will be taught using the Reporting method. In this study there 

are two variable namely independent variable (X) and dependent variable 

(Y). There are two variables in this research. According to Creswell 

(2009:50), independent variables related to variables can influence research 

results. According to Creswell (2009:50), dependent variables refer to 

variables that are influenced by free or independent variables. The 

independent variable (X) in this study is “The Effectiveness of Storytelling 

Method” while the dependent variable is “Teaching Speaking”. 

Table 3.2 Treatment Design for Experimental and Control Groups 

Experimental  Control  

O1 O1 

X Y 

O2 O2 
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B. Research Setting 

1. Place of Reseacrh 

The location used by the researcher in this study of MTs N 06 

Boyolali, which is located on the road of Cengklik Reservoir, Ngesrep, 

Ngemplak, Boyolali. The physical conditions and facilities include 

classrooms, playing fields, a library, a computer lab, a prayer room, a 

canteen, etc. Mts N 06 Boyolali is complete and adequate to support 

daily teaching and learning activities, so the researcher chose this 

location. 

2. Time of Research 

The time used by the reseacher for this research was carried  out 

from the date of issuance of the research permit in a period of 

approximately two months, one month of the data collcetion for pre-

research starting on October 5 to November 20, 2023 and I month of the 

data collection and data processing starting on Januari 1 to February 1, 

2024 which includes presentation in the form of a thesis and guidance 

process takes place. 

 

 

 

 

 

 



42 

 

 
 

C. Population, Sampling, and Sample 

1. Population  

"Population is a generalization area consisting of objects/subjects 

that have certain qualities and characteristics that are determined to be 

studied and then drawn conclusions," according to Sugiyono (2019). 

The existence of this population aims to reduce the validity of the 

generalization area and facilitate the estimation of the size of the sample 

members drawn from the population. In this research, the researcher 

takes the population from the 8th grade of MTs N 06 Boyolali. The 

description of the people of this research can be seen in the following 

table: 

Table 3.3 Population 

No. Class Number of Student 

1. VIII A 32 

2. VIII B 32 

3. VIII C 32 

4. VIII D 32 

5. VIII E 32 

6. VIII F 31 

7. VIII G 32 

8. VIII H 32 

9. VIII I 32 

 Total  287 

 

2. Sampling  

The cluster random sampling technique is a random sampling 

technique for groups, not just individually (Sugiyono, 2019: 83). This 

theory aligns with the opinion of (Azwar, 2010: 87), who says that 
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cluster random sampling is the randomization of groups, not individual 

subjects. In this research, the researcher used cluster random sampling 

technique to the total of population. It was used because the subjects of 

the study are homogeneous. The sample of this research weredivided 

into two groups. The sample of the class was VIII-A as an experimental 

class which was taught by using storytelling method and VIII-C as a 

control class which was taught by using reporting method. The process 

of cluster random sampling are: 

a. The reseacher makes list all classes 

b. The researcher writes class name on small paper and rolles the paper 

c. The researcher takes the rolled paper into a bottle 

d. The researcher shakes the bottle and takes two rolled paper. The first 

rolled paper is VIII-A and becomes experimental classand the 

second rolled paper is VIII-C and becomes control class. 

3. Sample  

According to Sugiyono (2015:188), a sample is part of the 

number and characteristics of the population. The sample is class VIII-

A as an Experimental group comprising 32 students and class VIII-C as 

an Control group comprising 32 students. The sample in this research 

was divided into two groups; one group was an experiment group that 

taught by the storytelling method, while the other group was a control 

group that taught by using the reporting method, which is a daily 

teaching-learning process used by the teacher. 
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Table 3.4 The Sample of the Research 

Group Class Men Women Total 

Experimental  VIII-A 14 18 32 

Control VIII-C 18 14 32 

    64 

 

D. Techniques of Collecting the Data 

Ridwan (2010: 51) states that data collection techniques are 

techniques or methods that the researcher can use to collect data. This 

research collects data using the try-out test, a pre-test, and a  post-test given 

to both the experimental and control classes. In this research, the researcher 

gave a pre-test to see students' basic speaking ability before using the 

storytelling method in teaching speaking class. The next was a post-test, 

which measured the effectiveness of the storytelling method in teaching 

speaking. 

1. Test 

a. Try Out Test 

Before the question instructions are implemented, the 

question instructions are tested. A trial is given to determine whether 

the instrument is readible or not. Before the speaking ability test was 

given to the experimental and control classes, it was first tested on a 

class not included in the research sample. The trial results were 

analyzed to determine the instrument's readability and whether any 

question instructions needed to be revised.  
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Based on the results of the try out given to class VIII E, it 

shows that more than 75% of respondents gave "yes" answers to 

each item of the readability test. So, it can be concluded that the 

instrument is readable. 

b. Pre-Test 

To know the students' speaking ability before treatment is 

given, the researcher will provide the students with a pre-test about 

speaking. Creswell (2012:297) states that a pre-test offers a measure 

of some attribute or characteristic that is assessed for the participant 

in an experiment before they receive treatment. 

c. Post-Test 

After conducting a pre-test and implementing treatment, the 

researcher will give a post-test to the students to know whether their 

ability to speak is increasing. Creswell (2012:297) states that a post-

test is a measure of some attribute or characteristic that is assessed 

by the participant in an experiment after a treatment. 

E. Research Instrument 

According to Creswell (2012), an instrument is a tool for measuring, 

observing, or documenting quantitative data. Oral tests are an instrument in 

this research. An oral test will be given to both groups as a pre-test and post-

test in the form of a sheet distributed to eighth-grade students. The 

researcher conducted oral tests on the pre-test and post-test to determine the 

effect of storytelling on the experimental group. The researcher instructed 
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students to explain themselves in front of the class. In creating research 

instruments, the researcher is guided by the readability of the instrument. 

Below is an instrument in the form of a blueprint-speaking test table. 

Table 3.5 Blue Print of  Speaking Test 

Competence 

Standard 

Construct Indicators Instrument 

Speaking :  

1. Describe 

yourself 

 

 

Notes : 

(It is adapted 

from English 

Language in 

MTs N 06 

Boyolali) 

Speaking is an 

activity to 

explain someone 

in a particular 

situation or an 

action to report 

something. 

1. Pronunciation 

Accuracy 

2. Intonation 

Accuracy 

3. Fluency 

4. Word Choice 

Oral test by 

describing 

myself 

according to 

indicators in 

speaking 

 

F. Data Validation 

An instrument can be said to be good if it meets two essential 

requirements, namely valid and reliable and readible (Suharsimi Arikunto, 

2010: 211). In this study, to determine readability of the instrument, a trial 

of the instrument was conducted before the research. The results of this trial 

will later become the basis for determining the readability of the instrument. 

Readability  

Readability was used to know whether the instruction was readable by 

the students or not; it was essential because the students were instructed to 

make a text with some certainties. Some questions could measure the 

readability. Hughes (1996:39-40) mentioned some factors to write a good 
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instruction. Frist, the instruction should be clear and explicit. Second, it 

should avoid the supposition that students all reveal what is intended. Third, 

the test writer should focus on the students' power of telepathy to elicit the 

desired behavior. The instruction should be understood and essayed by the 

students. The researcher conducted a readability test on English subjects in 

classes VIII A and VIII B MTS N 06 Boyolali. 

The instruction for the speaking test is: 

1. The researcher provides instructions to students to move forward with 

the topics that have been prepared. 

2. Students come to the front of the class individually. 

3. Students explain according to the topic provided about yourself. 

4. The researcher assesses students' abilities according to the indicators 

used. 

Readibility of speaking test contatins: 

1. Whether the instructions are understandable  or not, 

2. Whether the kind of the instructions is clear or not, 

3. Whether the organization of the sentences is understandable or not, 

4. Whether the speaking indicator to be evaluated are clear or not, 

5. Whether the topics are interesting or not. 

Readibility of test item: 

1. Do you understand the instructions of this test? 

2. Is the kind of the sentences to be speak in this test stated clearly? 
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3. Is the organization of the sentences demanded in this test 

understandable? 

4. Are the speking indicators to be evaluated in this test clear?  

5. Are the topics interenting? 

To know the whether the test ws readable or not, the try out is given 

to other students out of the samples having the same level as the sample. The 

result is more than 75% of respodents give “yes” answer to each item of 

readibility test. It can be concluted that the item of speaking test is readible. 

G. Techniques of Analyzing the Data 

Data analysis techniques are intended to find answers to research 

questions or problems previously formulated. As stated by Sugiyono (2007: 

207), data analysis is the activity of grouping data based on variables and 

types of respondents, tabulating data based on variables and types of 

respondents, presenting data for each variable studied, carrying out 

calculations to test the hypotheses that have been proposed. In this analysis, 

the researcher used several statistical methods and presented the following 

descriptive statistics for the sample under study: 

1. Descriptive Analysis 

Descriptive analysis is data analysis by describing or illustrating 

the data that has been collected as it is. According to Sugiyono (2013), 

descriptive analysis is a method that functions to explain or provide an 

overview of an object being studied through data or samples that have 
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been collected as they are without carrying out analysis to make 

conclusions that apply to the general public. 

a. Frequency Distibution 

According to Riduwan (2003), frequency distribution is the 

arrangement of data, starting from the smallest data to the largest, 

which divides the amount of data into several classes. The use of 

data transformed in the form of a frequency distribution is to make 

it easier to present, easy to understand, and easy to read as 

information. The steps to find mean in SPSS 26 as follows: 

1) Open SPSS 26 on your device. Select File > New Data.  

 

 

 

 

 

 

 



50 

 

 
 

2) Click Variable View at the bottom left corner, then type your 

data title in the Name column. Give a name to the label column, 

change of the decimal column to “0” and the measure column to 

scale as shown below. 

 

3) Copy and paste your posttest results from Excel to SPSS 26 in 

Data View. 
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4) After the data is included in SPSS 26, click Analyze Descriptive 

Statistic > Frequencies. 

 

5) A dialog box will appear as shown below. Move all variables on 

the left side to the Variable(s) column on the right side. Then 

click Frequencies put a check mark on Display Frequency 

Table > Ok. 
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6) The frequency distibution mean result will appear as shown 

below. 

 

b. Mean  

The mean is simply the arithmetic average of all the scores. 

It is calculated by summing all the scores and then dividing the sum 

by the number of scores (MacMillan & Schumacher, 2001). The 

steps to find mean in SPSS 26 as follows:  
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1) Open SPSS 26 on your device. Select File > New Data.  

 

2) Click Variable View at the bottom left corner, then type your 

data title in the Name column. Give a name to the label column, 

change of the decimal column to “0” and the measure column to 

scale as shown below. 

 

3) Copy and paste your Pre-test and Posttest results from Excel to 

SPSS 26 in Data View. 
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4) After the data is included in SPSS 26, click Analyze Descriptive 

Statistic > Descriptives. 

 

5) A dialog box will appear as shown below. Move all variables on 

the left side to the Variable(s) column on the right side. Then 

click Options > put a check mark on Mean, and Sum > 

Continue > Ok. 

 

6) The mean result will appear as shown below. 
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c. Median  

The median is that point which divides  a rank-ordered 

distribution into halves that have an equal number of scores 

(MacMillan & Schumacher, 2001). The steps to find median in SPSS 

26 as follows: 

1) Open SPSS 26 on your device. Select File > New Data. 

 

2) Click Variable View at the bottom left corner, then type your 

data title in the Name column. Give a name to the label column, 

change the name of the decimal column to (0) and the measure 

column to scale as shown below. 
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3) Copy and paste your posttest results from Excel to SPSS 26 in 

Data View. 

 

4) After the data is included in SPSS 26, click Analyze > 

Descriptive Statistic > Frequencies. 

 

5) A dialog box will appear as shown below. Move all variables on 

the left side to the Variable(s) column on the right side. Then 

click Options > put a check mark on Median, Mode, Sum > 

Continue > Ok. 
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6) The median result will appear as shown below. 

 

d. Mode  

The mode is simply the score tht occurs most frequently in  

distributions (MacMillan & Schumacher, 2001). The steps to find 

mode in SPSS 26 as follows: 

1)  Open SPSS 26 on your device. Select File > New Data. 

 

2) Click Variable View at the bottom left corner, then type your 

data title in the Name column. Give a name to the label column, 

change the name of the decimal column to (0) and the measure 

column to scale as shown below. 
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3) Copy and paste your posttest results from Excel to SPSS 26 in 

Data View. 

 

4) After the data is included in SPSS 26, click Analyze > 

Descriptive Statistic > Frequencies. 
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5) A dialog box will appear as shown below. Move all variables on 

the left side to the Variable(s) column on the right side. Then 

click Options > put a check mark on Mode, and Sum, Continue 

> Ok. 

 

6) The mode result will appear as shown below. 

 

e. Standart Deviation 

The standard deviation is a numerical index that indicates the 

average variability of the score. It tells us, in other words, about 

distance, on the average of the score from the mean (MacMillan & 
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Schumacher, 2001). The steps to find standard deviation in SPSS 26 

as follows:  

1) Open SPSS 26 on your device. Select File > New Data. 

 

2) Click Variable View at the bottom left corner, then type your 

data title in the Name column. Give a name to the label column, 

change the name of the decimal column to (0) and the measure 

column to scale as shown below. 
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3) Copy and paste your posttest results from Excel to SPSS 26 in 

Data View. 

 

4) After the data is included in SPSS 26, click Analyze > 

Descriptive Statistic > Descriptives. 
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5) A dialog box will appear as shown below. Move all variables on 

the left side to the Variable(s) column on the right side. Then 

click Options > put a check mark on Mean, Sum, Std. 

deviation, Variance Range, Minimum, Maximum, S.E. 

mean, Kurtosis, Skewness > Continue > Ok. 

 

6) The standard deviation result will appear as shown below. 

 

2. Pre-Requisite Test 

a. Normality Test 

According to Burke (2000:119) normality test is done 

towards two classes those are experimental class and control class. 

Normality test is used to know whether the data from both sample 

groups which is exammined comes from the population of normal 
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distribution or not. Hidayat (2014) states to know the normality of 

the sample, the researcher used  basic decisions as follows: 

1) If the value of sig. (2-tailed) > 0,05, so the data is normally 

distributed 

2) If the value of sig. (2-tailed) < 0,05 so the data is not normally 

distributed 

To determine if the data is normally distributed or not, the 

reseacher used SPSS with Shapiro-wilk as the normality test. Bellow 

are the procedure of normality test using Shapiro-wilk through SPSS 

26. There are the following steps to calculate normality test: 

1) Open SPSS 26 on your device. Select File > New Data. 

 

2) Click Variable View on the botton left corner, then type 

PRETEST and POSTTEST in the Name column. 
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3) Then, click Data View in the bottom left corner, then enter the 

POSTTEST data in the columns provided. 

 

4) After the data is included in SPSS 26, click Analyze > 

Descriptive Statistics > Explore. 

 

5) A dialog box will appear as shown below. Move all variables 

(POSTTEST) on the left side to the Dependent List box on the 

right side. 
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6) Then, click Plots and put a check mark on Normality plots with 

tests > Continue > Ok. 

 

7) The results of the normality test will appear as shown below. 

 

b. Homogeneity  

According to Burke (2002: 118)  state that homogeneity test 

is used to know the similarity of the two conditions or population. 

Homogenety test is used to know whether two groups (experiment 

and control class) that are taken from population have homogeneity 

or not. The homogeneity test was carried out using the Levene 

statistical test with the significance level of 5% (∝ = 0.05). Hidayat 

(2014) states to know the homogeneity of the sample, the reseacher 

used the basic decisions as follows: 

1) If Sig. < 0,05, the data is not homogeneous 

2) If Sig. > 0,05, the data is homogeneous 
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To determine if the data is homogen or not, the reseacher 

used SPSS with Levene as the homogeneity test.  Below are the 

procedure of homogeneity test using Levene through SPSS 26. The 

steps of homogeneity are as follow: 

1) Open SPSS 26 on your device. Select File > New Data.  

 

2) Click Variable View on the bottom left corner, then change each 

variable name as shown below. 
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3) Then, click Data View and input the speaking test result for the 

Experimental class followed by the Control class below. Type 

the code for each class for each data as previously inputted. 

 

4) After the data is included in SPSS 26, click Analyze > Compare 

Means > One-Way ANOVA. 
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5) A dialog box will appear as shown below. Move the Speaking 

Test Result variable to the Dependet box on the right side, and 

the Class variable to the Factor box on the right side. 

 

6) Click Options on the dialog box, put a check mark on 

Homogeneity of variance test > Continue > Ok. 

 

7) The homogeneity test results will appear as shown below. 
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3. Hypothesis Testing  

According to (Sekaran 2016), hypothesis testing is a type of 

research that explains several relationships and influences between 

variables. To calculate the significant difference between the mean score 

of the students’ by calculating the value of One Sample t-test used SPSS 

26 for windows program. 

a. t-Test 

According to Sugiyono (2018; 223), the t-test is a temporary 

answer to the problem formulation, which asks about the 

relationship between two or more variables. According to Sujarweni 

(2019), One sample t-test is a comparative test to test the 

significance of the difference between an average value and a certain 

value (test value). To know the One Sample t-test, the reseacher used 

the basic decisions as follows: 

1) If the probability value or Sig. (2-tailed) < 0.05, then Ha is 

accepted 

2) If the probability value or Sig. (2-tailed) > 0.05, then Ha is 

rejected 

Hypothesis testing design determines the effect of the two 

variables studied. To test the hypothesis, see the differences and 

effects of using Storytelling Method at the eighth-grade of MTs N 

06 Boyolali in the academic year 2023/2024. The researcher used 



70 

 

 
 

SPSS with One t-test as the hypothesis test. The following is the One 

t-test procedure throught SPSS 26. 

1) Open SPSS 26 on your device. Select File > New Data. 

 

2) Click Variable View on the bottom  left corner, then type 

POSTTEST EXPERIMENT and POSTTEST CONTROL in 

the Name column. 
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3) Then, click Data View in the bottom left corner, then enter the 

POSTTEST EXPERIMENT and POSTTEST CONTROL data 

in the columns provided. 

 

4) After the data is included in SPSS 26, click Anlayze > Compare 

Means > One Sample t-test. 
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5)  A dialog box will apear as shown below. Move all variables 

(POSTTEST EXPERIMENT POSTTEST CONTROL) on 

the left side to the Test Variable box on the right side. On the 

Test Value write 75. 

 

6) Then, click Ok. The t-test results will appear as shown below. 
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CHAPTER IV 

RESEARCH FINDING AND DISCUSSIONS 

A. Research Finding 

1. Data Descriptions 

The objective of this research is to find out whether there is or is 

not a significant difference between students who are taught to use the 

storytelling method and those who are taught the reporting method in 

speaking descriptive text. This research also aims to determine whether 

the storytelling method is effective in teaching speaking. The researcher 

took two classes as samples. The classes are VIII A as the experimental 

group, consisting of 32 students who are taught using the storytelling 

method, and VIII C as the control group, consisting of 32 students who 

are taught using the reporting method. 

After conducting the experiment, the researcher obtained the 

desired data. The data which are analyzed in this research are the pre-

test and post-test scores of the two groups, the experimental and control 

groups. The post-test scores of both groups are compared using a t-test. 

The data description of each group is presented as follows: 

a. Frequency Distribution 

Based on the table below, there are frequencies of post-test 

experiment and post-test control groups. The post-test of the 

experimental class concluded that two students scored 65 with a 

percentage of 6.3%. Furthermore, six students got a score of 70, 
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with a percentage of 18.8%. Then, eight students earned a score of 

75, which is a percentage of 25.0%. Eight students scored 80, with 

a percentage of 20.0%. Furthermore, five students scored 85, with 

a presentation of 15.6. Finally, three students earned a score of 90 

with a percentage of 9.4%. 

It can also be concluded from the post-test of the control 

class that four students scored 65 with a percentage of 12.5%. 

Furthermore, seven students earned a score of 70, a percentage of 

21.9%. Then, nine students scored 75, a percentage of 28.1%. Eight 

students earned a score of 80, a percentage of 25.0%. Then, two 

students got a score of 85, a percentage of 6.3%. Finally, two 

students earned a score of 90 with a percentage of 6.3%. 

Table 4.1 Frequency Distribution  

Post-test Eksperiment 

 Frequency Percent 

Valid 

Percent 

Cumulative 

Percent 

Valid 65 2 6.3 6.3 6.3 

70 6 18.8 18.8 25.0 

75 8 25.0 25.0 50.0 

80 8 25.0 25.0 75.0 

85 5 15.6 15.6 90.6 

90 3 9.4 9.4 100.0 

Total 32 100.0 100.0  
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Post-test Control 

 Frequency Percent 

Valid 

Percent 

Cumulative 

Percent 

Valid 65 4 12.5 12.5 12.5 

70 7 21.9 21.9 34.4 

75 9 28.1 28.1 62.5 

80 8 25.0 25.0 87.5 

85 2 6.3 6.3 93.8 

90 2 6.3 6.3 100.0 

Total 32 100.0 100.0  

 

 

Figure 1 Histogram of Experimental Class 

 

Figure 2 Histogram of Control Class 
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b. Mean  

Based on the table below, there are averages of the pre-test 

and post-test in the experimental and control classes. The average 

that can be concluded in the experimental class is that students 

received an average score of 65.94 before being given treatment. 

Then, after they received treatment in the form of a storytelling 

method, there was a change in the average score to 77.66. Then, the 

average that can be concluded in the control class is that students 

received an average score of 62.19 before being given treatment. 

Then, after receiving treatment in the form of a reporting method, 

there was a change in the average value to 75.47. 

Table 4.2 Mean of Experimental and Control Groups 

 

N Sum Mean 

Statistic Statistic Statistic 

Pre-test Experiment 32 2110 65.94 

Post-test Experiment 32 2485 77.66 

Pre-test Control 32 1990 62.19 

Post-test Control 32 2415 75.47 

Valid N (listwise) 32   

c. Median  

Based on the table below, the median of the post-test for the 

experimental class and control classes is shown. The median of the 

experimental class can be concluded to be 77.50. The median 

control class can be concluded as 75.00. 



77 

 

 
 

Table 4.3 Median Of Experimental and Control Groups 

Post-test 

Experiment 

Post-test 

Control 

32 32 

0 0 

77.50 75.00 

d. Mode  

Based on the table below, there are post-test modes for the 

experimental and control classes. The experimental class mode can 

be concluded to be 75. The control class mode can also be 

concluded as 75. 

Table 4.4 Mode Of Experimental and Control Groups 

 

Post-test 

Experiment 

Post-test 

Control 

N Valid 32 32 

Missing 0 0 

Mode 75a 75 

Sum 2485 2415 

a. Multiple modes exist. The smallest value is shown 

e. Standart Deviation 

Based on the table below, there is a standard deviation from 

the post-test for the experimental and control classes. The standard 

deviation for the Experimental class can be concluded to be 6.954. 

The control class standard deviation can be concluded as 6.763. 
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Table 4.5 Standard Deviation 

 N Sum 

Std. 

Deviation 

Post-test 

Experiment 

32 2485 6.954 

Post-test Control 32 2415 6.763 

Valid N (listwise) 32   

2. Pre-Requisite Test 

a. Normality Test 

The normality test is to know that the sample is in normal 

distribution. In the normality test, there is an indicator called 

significance value. If the data has a significance value higher than 

0.05, it means the data is normal for both Kolmogorov-Swirnov 

and Shapiro-Wilk. If the sample is less than 50, the Shapiro Wilk is 

more suitable for use in the normality test. Meanwhile, for large 

samples of more than 50, the Kolmogorov-Smirnov is used for 

more accurate results. In this case, the total of this research sample 

is 64, then the Kolmogorov-Smirnov result of the normality test is 

used. The following are the results of the normality test: 

Table 4.6 Test of Normality 

Class  

  

Kolmogorov-Smirnov 

Statistic Df Sig. 

Score POST EXP 0.149 32 0.070 

POST CTRL 0.153 32 0.056 
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b. Homogeneity Test 

The homogeneity test was carried out after it was known that 

the research data were normally distributed. The homogeneity test 

is a test used to determine whether the data variants from two or 

more groups are homogeneous or heterogeneous. Here is the result 

of the homogeneity test: 

Table 4.7 Test of Homogeneity 

Levene Statistic df1 df2 Sig. 

0.267 1 62 0.607 

 

In the homogeneity test result, if the significance value (Sig.) 

> 0.05, then the data is homogeneous. But, if the significance value 

(Sig.) < 0.05, then the data population group is not homogeneous, 

and the result showed that the significance value (Sig.) was 0.607 

> 0.05, which means the research data was homogeneous. 

3. Hypothesis Testing 

a. Hypothesis Testing of the Significance Differences Between 

Students who are Taught Using Story Telling Method With Those 

who are Taught Using Another Method in Teaching Speaking at the 

Eighth Grade Students of Mts N 06 Boyolali In The Academic Year 

Of 2023/2024  
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Hypothesis testing aims to decide whether the hypothesis 

being tested is rejected or accepted. In this study, the researcher 

used one sample t-test. One sample t-test is a comparative test to 

test the significance of the difference between an average value and 

a certain value (test value). In this case, the data being compared 

are the post-test scores of the experimental and the control groups. 

The results of the one-sample t-test are in the table bellow: 

Table 4.8 One Sample t-test 

     95% 

Confidence 

Interval of the 

Difference 

 t Df Sig (2-

tailed) 

Mean 

differences 

Lower Upper 

Post 

Exp 

2.161 31 0.039 2.656 0.15 5.16 

Post 

Ctrl 

0.392 31 0.698 496 -1.97 2.91 

 

Based on the results of the hypothesis test in the table above, 

it shows that the value of Sig. (2-tailed) is 0.039 < 0.05. Then, it 

can be concluded that there is a significant difference between the 

students who are taught by using the storytelling method and the 

students who are taught by using the reporting method to the eighth 

grade students of MTs N 06 Boyolali in the academic year of 

2023/2024.  
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b. Hypothesis of the Effectiveness Level of Storytelling Method and 

Reporting Method in Teaching Speaking at the Eighth Grade 

Students of MTs N 06 Boyolali in the Academic Year of 2023/2024 

Hypothesis testing aims to decide whether the hypothesis 

being tested is rejected or accepted. In this study, the researcher 

used the mean to determine the average value of the overall total 

score given by respondents. In this case, the data being compared 

are the pre-test and post-test scores of the experimental group. The 

results of the mean are in the table below: 

Table 4.9 Mean of Experimental and Control Groups 

 

N Sum Mean 

Statistic Statistic Statistic 

Pre-test Experiment 32 2110 65.94 

Post-test 

Experiment 

32 2485 77.66 

Pre-test Control 32 1990 62.19 

Post-test Control 32 2415 75.47 

Valid N (listwise) 32   

 

The results above show that the mean pre-test score of the 

experimental group is 65.94, and the mean post-test score of the 

experimental group is 77.66. Then, the mean pre-test of the control 

group is 62.19, and the mean post-test of the control group is 75.47. 

It means the score of the Experimental group, which was taught the 

Storytelling method, was higher than that of the control group, 
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which was taught the reporting method. Therefore, it can be 

concluded that the storytelling method is effective in teaching 

speaking to the eighth grade students of MTs N 06 Boyolali in the 

academic year of 2023/2024. 

B. Discussions  

In this research, the researcher discusses two things the researcher 

has researched and the results obtained. The researcher first discussion 

discussed significant differences. Then, in the second discussion, the 

researcher discussed the effectiveness of the methods in this research. 

Below is a discussion of these two things: 

1. The Significance Differences Between Students who are Taugh Using 

Story Telling Method with Those who are Taught Using Another 

Method in Teaching Speaking at the Eighth Grade of MTs N 06 

Boyolali in the Academic Year of 2023/2024  

According to Hardiyanti Rahmah and Hikmatu Ruwaida (2020), 

the method of Storytelling is very significant in students' English 

speaking skills. According to Barker & Grower (2010), the storytelling 

method is a method that teachers can use to create fun learning by the 

principles of learning in early childhood education. This is acceptable 

because, through teaching activities that apply the storytelling method, 

students are happier and more creative in learning. The pre-test and 

post-test results of the experimental group prove this. 
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Based on the hypothesis test results, there are posttest results in 

both classes, namely the experimental class with learning using the 

storytelling method and the control class with learning using the 

reporting method. The results of hypothesis testing using the one 

sample test show that the posttest score in the experimental class using 

the storytelling method is Sig. (2-tailed) is 0.039 < 0.05, which means 

it is accepted. Meanwhile, the posttest value in the control class using 

the reporting method is the Sig value. (2-tailed) is 0.698 > 0.05, which 

means it is rejected. 

Based on the results above, data analysis shows that there are 

differences between the experimental group and the control group. It 

can be seen that the posttest value in the experimental class was 

accepted, while the posttest value in the control class was rejected. So, 

there is a significant difference between students taught using the 

storytelling method and those taught using the reporting method at the 

eighth grade students of MTs N 06 Boyolali in the academic year of 

2023/2024. 

2. The Effectiveness Level of Storytelling Method and Reporting Method 

in Teaching Speaking at the Eighth Grade of MTs N 06 Boyolali in the 

academic Year of 2023/2024 

Tamala (2019) and Pratiwi (2016) argue that Storytelling is one 

of the most effective ways to achieve the goals of learning students' 

speaking skills in class. With this method, the class atmosphere 
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becomes more fun and lively. So, it is not surprising that it is revealed 

that Storytelling is a comprehensive concept that breaks down the 

boundaries between formal and informal learning in socio-cultural 

studies. According to Nurmiyati and Pujiati Suyata (2014) stated that 

pair storytelling is the most effective method for English-speaking 

competency in narrative text types. 

Based on the result, there are averages of the pre-test and post-

test in the experimental and control classes. The average that can be 

concluded in the experimental class is that students received an average 

score of 65.94 before being given treatment. Then, after they received 

treatment in the form of a storytelling method, there was a change in 

the average score to 77.66. Then, the average that can be concluded in 

the control class is that students received an average score of 62.19 

before being given treatment. Then, after receiving treatment in the 

form of a reporting method, there was a change in the average value to 

75.47. 

Based on the results above, it can be concluted that the score of 

the experimental group, which was taught the storytelling method, was 

higher than that of the control group, which was taught the reporting 

method. Therefore, it can be concluded that the storytelling method is 

effective in teaching speaking to the eighth grade students of MTs N 06 

Boyolali in the academic year of 2023/2024. 
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Based on the conclusions that have been stated, that there is a 

significant difference between students taught using the storytelling method, 

and taught using the reporting method. This proves that the storytelling 

method is effective in teaching speaking to the eighth grade of MTs N 06 

Boyolali.  

The implication of this research is that teachers must also adapt to 

students' learning models in each learning activity, then teachers prepare and 

design varied teaching methods so that they can stimulate students' desire to 

learn and can develop students' speaking skills. From the results of data 

processing, it can be seen that the storytelling method can provide 

significant changes to students' speaking abilities when teaching speaking. 

Apart from that, students must consistently practice speaking English 

through other methods so that their ability to speak English continues to 

develop students speaking skill. 
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CHAPTER V 

CONCLUSIONS AND SUGGESTIONS 

A. Conclusions  

This research aims to determine whether the storytelling method is 

effective in teaching speaking with descriptive text material to eighth-grade 

students at MTs N 06 Boyolali. To achieve the research objectives, the 

researcher conducted experimental research. After conducting research, the 

researcher know the results. After analyzing the data, the researcher 

obtained the results of the analysis. 

Based on the hypothesis test results, there are posttest score results 

in both classes, namely the experimental and control classes. The results of 

hypothesis testing using the one sample t-test show that the posttest score in 

the experimental class using the storytelling method is Sig. (2-tailed) is 

0.039 < 0.05, which means it is accepted. Meanwhile, the posttest value in 

the control class using the reporting method is the Sig value. (2-tailed) is 

0.698 > 0.05, which means it is rejected. 

Based on the results above, the analysis shows that there are 

differences between the experimental group and the control group. It can be 

seen that the posttest value in the experimental class was accepted, while 

the posttest value in the control class was rejected. Therefore, it can be 

concluded that there is a significant difference between students taught 

using the storytelling method, and students taught using the reporting 
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method at the eighth grade students of MTs N 06 Boyolali in the academic 

year of 2023/2024. 

Based on the result, there are mean of the pre-test and post-test in 

the experimental and control classes. The mean score that can be concluded 

in the experimental class is that students received an average score of 65.94 

before being given treatment. Then, after they received treatment in the form 

of a storytelling method, there was a change in the average score to 77.66. 

Then, the mean that can be concluded in the control class is that students 

received an average score of 62.19 before being given treatment. Then, after 

receiving treatment in the form of a reporting method, there was a change 

in the average value to 75.47. 

Based on the results above, it can be concluded that the score of the 

experimental group, which was taught the storytelling method, was higher 

than that of the control group, which was taught the reporting method. 

Therefore, it can be concluded that the storytelling method is effective in 

teaching speaking to the eighth grade students of MTs N 06 Boyolali in the 

academic year of 2023/2024. 

B. Suggestions 

Based on the results of the research, the researcher would like to 

porpose several suggestions, as follows: 

1. For the Teacher  

Teaching English is a complex matter; therefore, to make the 

students interested in this subject, teachers should use various methods, 
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techniques, and strategies in their teaching process. Teachers can choose 

appropriate methods and techniques based on the situation. Therefore, 

the class will not run in a boring atmosphere, and the students will enjoy 

the speaking process. Since this research shows that the storytelling 

method is better than the reporting method for teaching speaking skills, 

it is recommended that teachers use the storytelling method in teaching 

speaking. 

2. For the School Principles  

School principals should pay closer attention to the number of 

support learning facilities teachers need. The improvement of learning 

quality and educational standards is significantly influenced by adequate 

facilities and infrastructure. 

3. For the Students  

The Students have to improve their competence of speaking skills 

with the various activities individually, in pairs, or groups. Speaking is 

not only a productive skill with a complex challenge but also very 

important to support academic success. It is also a requirement for many 

occupations and professions. Using storytelling, the students can speak 

English actively and apply a new experience in their learning process. 

4. For the Future Research  

The research can reference another researcher that can be 

implemented to teach speaking. Other research can be developed with 

their material suitable for teaching speaking. 
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APPENDIX 

APPENDICES 1 

Lesson Plan of Experimental Group 

RENCANA PELAKSANAAN PEMBELAJARAN (RPP) 

Kelas Eksperimen 

Sekolah  : MTs N 06 Boyolali   Kelas  : VIII A 

Mata Pelajaran: Bahasa Inggris   Alokasi Waktu : 2 x 45 Menit 

KD 3.7 Membandingkan fungsi sosial, 

struktur teks, dan unsur kebahasaan 

berupa teks deskriptif lisan dan tulis 

dengan memberi dan meminta 

infromasi terkait dengan deskripsi 

orang, binatang, dan benda, sangat 

pendek dan sederhana, sesuai dengan 

konteks penggunaanya. 

KD 4.7.1 Menangkap makna secara 

kontekstual terkait fungsi sosial, 

struktur teks, dan unsur kebahasaan 

teks deskriptif lisan dan tulis, sangat 

pendek dan sederhana, terkait orang, 

binatang, dan benda. 

KD 4.7.2 Menyusun teks deskriptif 

lisan dan tulis, sangat pendek dan 

sederhana, terkait orang, binatang, dan 

benda, dengan memperhatikan fungsi 

sosial, strukter teks, dan unsur 

kebahasaan, secara benar dan sesuai 

konteks.  

 

➢ TUJUAN PEMBELAJARAN 

Setelah mengikuti proses pembelajaran, peserta didik diharapkan dapat: 

- Memahami Fungsi Sosial dari mendeskripsikan, mengidentifikasi, 

mengkritisi, memberikan penilaian tentang orang, binatang, dan benda dari 

segi sifatnya. 

- Mengidentifikasi sifat seseorang (kind, nice, friendly, ect) 

 

Media Pembelajaran, Sumber Belajar & Metode Pembelajaran 

Media  

Alat/Bahan 

Sumber Belajar 

 

Metode Pembelajaran 

Lembar Penilaian 

Spido, Papan Tulis & Laptop 

Buku Penunjang Kurikulum 2013 Mata Pelajaran 

Bahasa Inggris 

Storytelling Method 

 



93 

 

 

➢ KEGIATAN PEMBELAJARAN 

Pertemuan ke-1 

Pendahuluan 10 menit 

• Melakukan pembukaan dengan salam pembuka dan berdoa untuk memulai 

pembelajaran 

• Menanyakan kabar, mengecek kehadiran, dan mengapresiasi kehadiran siswa 

sebagai sikap disiplin 

• Menyampaikan motivasi tentang apa yang dapat diperoleh (tujuan & 

manfaat) dengan mempelajari materi : Teks Deskripsi  

• Menjelaskan hal-hal yang akan dipelajari, kompetensi yang akan dicapai, 

serta metode belajar yang akan ditempuh 

Kegiatan Inti 70 Menit 

Eksplorasi 

• Memberikan stimulus berupa pemberian materi mengenai Tesk Deskrisi 

• Mendiskusikan materi bersama siswa (Buku LKS : Bahan ajar Bahasa Inggris 

mengenai pertanyaan apa itu teks deskripsi 

• Siswa menyimak materi yang disampaikan oleh guru  

• Siswa diminta membahas contoh teks deskripsi dalam buku LKS : Bahan ajar 

Bahasa Inggris mengenai Deskripsi 

Kolaborasi 

• Membiasakan siswa membuat teks yang mendeskripsikan orang, binatang, 

atau benda. 

• Memfasilitasi siswa melalui pemberian tugas mengerjakan latihan yang 

dikerjakan secara mandiri 

• Guru memberikan perintah kepada siswa bercerita tentang hasil belajar siswa 

Konfirmasi 

• Memberikan umpan balik pada siswa dengan memberi penguatan dalam 

bentuk lisan pada siswa yang telah menyelesaikan tugasnya 

• Memfasilitasi siswa melakukan refleksi untuk memperoleh pengalaman 

belajar yang sudah dilakukan 

• Siswa diminta membuat rangkuman secara mandiri mengenai materi Teks 

Deskripsi 

Kegiatan Akhir 10 Menit 

• Guru dan siswa melakukan tanya jawab tentang materi yang telah dipelajari 

untuk mengetahui hasil ketercapaian siswa 

• Memberikan motivasi kepada siswa yang kurang dan belum bisa megikuti 

materi mengenai Teks Deskripsi 

• Mengucapkan salam dan menyampaikan rencana pembelajaran pada 

pertemuan berikutnya 
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➢ PENILAIAN HASIL PEMBELAJARAN 

- Penilaian Pengetahuan; berupa test tertulis uraian, test lisan, observasi 

terhadap diskusi tanya jawab serta penguaaan materi 

- Penilaian Keterampilan; berupa peniliaian unjuk kerja, penilaian proyek, 

penilaian produk dan penilaian portofolio 

 

 

 

Boyolali, 12 Januari 2024 

 

Mengetahui 

Guru Bahasa Inggris MTs N 06 Boyolali  Mahasiswa 

 

 

 

 

___________________________  Rosalia Mega Artikarini 

NIP.      NIM. 206121243 
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RENCANA PELAKSANAAN PEMBELAJARAN (RPP) 

Kelas Eksperimen 

Sekolah  : MTs N 06 Boyolali   Kelas  : VIII A 

Mata Pelajaran: Bahasa Inggris   Alokasi Waktu : 2 x 45 Menit 

KD 3.7 Membandingkan fungsi sosial, 

struktur teks, dan unsur kebahasaan 

berupa teks deskriptif lisan dan tulis 

dengan memberi dan meminta 

infromasi terkait dengan deskripsi 

orang, binatang, dan benda, sangat 

pendek dan sederhana, sesuai dengan 

konteks penggunaanya. 

KD 4.7.1 Menangkap makna secara 

kontekstual terkait fungsi sosial, 

struktur teks, dan unsur kebahasaan 

teks deskriptif lisan dan tulis, sangat 

pendek dan sederhana, terkait orang, 

binatang, dan benda. 

KD 4.7.2 Menyusun teks deskriptif 

lisan dan tulis, sangat pendek dan 

sederhana, terkait orang, binatang, dan 

benda, dengan memperhatikan fungsi 

sosial, strukter teks, dan unsur 

kebahasaan, secara benar dan sesuai 

konteks.  

 

➢ TUJUAN PEMBELAJARAN 

Setelah mengikuti proses pembelajaran, peserta didik diharapkan dapat: 

- Memahami Fungsi Sosial dari mendeskripsikan, mengidentifikasi, 

mengkritisi, memberikan penilaian tentang orang, binatang, dan benda dari 

segi sifatnya. 

- Mengidentifikasi sifat seseorang (kind, nice, friendly, ect) 

 

Media Pembelajaran, Sumber Belajar & Metode Pembelajaran 

Media  

Alat/Bahan 

Sumber Belajar 

 

Metode Pembelajaran 

Lembar Penilaian 

Spido, Papan Tulis & Laptop 

Buku Penunjang Kurikulum 2013 Mata Pelajaran 

Bahasa Inggris 

Storytelling Method 
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➢ KEGIATAN PEMBELAJARAN 

Pertemuan ke-2 

Pendahuluan 10 menit 

• Melakukan pembukaan dengan salam pembuka dan berdoa untuk memulai 

pembelajaran 

• Menanyakan kabar, mengecek kehadiran, dan mengapresiasi kehadiran siswa 

sebagai sikap disiplin 

• Menyampaikan motivasi tentang apa yang dapat diperoleh (tujuan & 

manfaat) dengan mempelajari materi : Teks Deskripsi  

• Menjelaskan hal-hal yang akan dipelajari, kompetensi yang akan dicapai, 

serta metode belajar yang akan ditempuh 

Kegiatan Inti 70 Menit 

Eksplorasi 

• Memberikan stimulus berupa pemberian materi mengenai Tesk Deskrisi 

• Mendiskusikan materi bersama siswa (Buku LKS : Bahan ajar Bahasa Inggris 

mengenai pertanyaan apa itu teks deskripsi 

• Siswa menyimak materi yang disampaikan oleh guru  

• Siswa diminta membahas contoh teks deskripsi dalam buku LKS : Bahan ajar 

Bahasa Inggris mengenai Deskripsi 

Kolaborasi 

• Membiasakan siswa membuat teks yang mendeskripsikan orang, binatang, 

atau benda. 

• Memfasilitasi siswa melalui pemberian tugas mengerjakan latihan yang 

dikerjakan secara mandiri 

• Guru memberikan perintah kepada siswa bercerita tentang hasil belajar siswa 

Konfirmasi 

• Memberikan umpan balik pada siswa dengan memberi penguatan dalam 

bentuk lisan pada siswa yang telah menyelesaikan tugasnya 

• Memfasilitasi siswa melakukan refleksi untuk memperoleh pengalaman 

belajar yang sudah dilakukan 

• Siswa diminta membuat rangkuman secara mandiri mengenai materi Teks 

Deskripsi 

Kegiatan Akhir 10 Menit 

• Guru dan siswa melakukan tanya jawab tentang materi yang telah dipelajari 

untuk mengetahui hasil ketercapaian siswa 

• Memberikan motivasi kepada siswa yang kurang dan belum bisa megikuti 

materi mengenai Teks Deskripsi 

• Mengucapkan salam dan menyampaikan rencana pembelajaran pada 

pertemuan berikutnya 
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➢ PENILAIAN HASIL PEMBELAJARAN 

- Penilaian Pengetahuan; berupa test tertulis uraian, test lisan, observasi 

terhadap diskusi tanya jawab serta penguaaan materi 

- Penilaian Keterampilan; berupa peniliaian unjuk kerja, penilaian proyek, 

penilaian produk dan penilaian portofolio 

 

 

 

Boyolali, 12 Januari 2024 

 

Mengetahui 

Guru Bahasa Inggris MTs N 06 Boyolali  Mahasiswa 

 

 

 

 

___________________________  Rosalia Mega Artikarini 

NIP.      NIM. 206121243 
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RENCANA PELAKSANAAN PEMBELAJARAN (RPP) 

Kelas Eksperimen 

Sekolah  : MTs N 06 Boyolali   Kelas  : VIII A 

Mata Pelajaran: Bahasa Inggris   Alokasi Waktu : 2 x 45 Menit 

KD 3.7 Membandingkan fungsi sosial, 

struktur teks, dan unsur kebahasaan 

berupa teks deskriptif lisan dan tulis 

dengan memberi dan meminta 

infromasi terkait dengan deskripsi 

orang, binatang, dan benda, sangat 

pendek dan sederhana, sesuai dengan 

konteks penggunaanya. 

KD 4.7.1 Menangkap makna secara 

kontekstual terkait fungsi sosial, 

struktur teks, dan unsur kebahasaan 

teks deskriptif lisan dan tulis, sangat 

pendek dan sederhana, terkait orang, 

binatang, dan benda. 

KD 4.7.2 Menyusun teks deskriptif 

lisan dan tulis, sangat pendek dan 

sederhana, terkait orang, binatang, dan 

benda, dengan memperhatikan fungsi 

sosial, strukter teks, dan unsur 

kebahasaan, secara benar dan sesuai 

konteks.  

 

➢ TUJUAN PEMBELAJARAN 

Setelah mengikuti proses pembelajaran, peserta didik diharapkan dapat: 

- Memahami Fungsi Sosial dari mendeskripsikan, mengidentifikasi, 

mengkritisi, memberikan penilaian tentang orang, binatang, dan benda dari 

segi sifatnya. 

- Mengidentifikasi sifat seseorang (kind, nice, friendly, ect) 

 

Media Pembelajaran, Sumber Belajar & Metode Pembelajaran 

Media  

Alat/Bahan 

Sumber Belajar 

 

Metode Pembelajaran 

Lembar Penilaian 

Spido, Papan Tulis & Laptop 

Buku Penunjang Kurikulum 2013 Mata Pelajaran 

Bahasa Inggris 

Storytelling Method 
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➢ KEGIATAN PEMBELAJARAN 

Pertemuan ke-3 

Pendahuluan 10 menit 

• Melakukan pembukaan dengan salam pembuka dan berdoa untuk memulai 

pembelajaran 

• Menanyakan kabar, mengecek kehadiran, dan mengapresiasi kehadiran siswa 

sebagai sikap disiplin 

• Menyampaikan motivasi tentang apa yang dapat diperoleh (tujuan & 

manfaat) dengan mempelajari materi : Teks Deskripsi  

• Menjelaskan hal-hal yang akan dipelajari, kompetensi yang akan dicapai, 

serta metode belajar yang akan ditempuh 

Kegiatan Inti 70 Menit 

Eksplorasi 

• Memberikan stimulus berupa pemberian materi mengenai Tesk Deskrisi 

• Mendiskusikan materi bersama siswa (Buku LKS : Bahan ajar Bahasa Inggris 

mengenai pertanyaan apa itu teks deskripsi 

• Siswa menyimak materi yang disampaikan oleh guru  

• Siswa diminta membahas contoh teks deskripsi dalam buku LKS : Bahan ajar 

Bahasa Inggris mengenai Deskripsi 

Kolaborasi 

• Membiasakan siswa membuat teks yang mendeskripsikan orang, binatang, 

atau benda. 

• Memfasilitasi siswa melalui pemberian tugas mengerjakan latihan yang 

dikerjakan secara mandiri 

• Guru memberikan perintah kepada siswa bercerita tentang hasil belajar siswa 

Konfirmasi 

• Memberikan umpan balik pada siswa dengan memberi penguatan dalam 

bentuk lisan pada siswa yang telah menyelesaikan tugasnya 

• Memfasilitasi siswa melakukan refleksi untuk memperoleh pengalaman 

belajar yang sudah dilakukan 

• Siswa diminta membuat rangkuman secara mandiri mengenai materi Teks 

Deskripsi 

Kegiatan Akhir 10 Menit 

• Guru dan siswa melakukan tanya jawab tentang materi yang telah dipelajari 

untuk mengetahui hasil ketercapaian siswa 

• Memberikan motivasi kepada siswa yang kurang dan belum bisa megikuti 

materi mengenai Teks Deskripsi 

• Mengucapkan salam dan menyampaikan rencana pembelajaran pada 

pertemuan berikutnya 
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➢ PENILAIAN HASIL PEMBELAJARAN 

- Penilaian Pengetahuan; berupa test tertulis uraian, test lisan, observasi 

terhadap diskusi tanya jawab serta penguaaan materi 

- Penilaian Keterampilan; berupa peniliaian unjuk kerja, penilaian proyek, 

penilaian produk dan penilaian portofolio 
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RENCANA PELAKSANAAN PEMBELAJARAN (RPP) 

Kelas Eksperimen 

Sekolah  : MTs N 06 Boyolali   Kelas  : VIII A 

Mata Pelajaran: Bahasa Inggris   Alokasi Waktu : 2 x 45 Menit 

KD 3.7 Membandingkan fungsi sosial, 

struktur teks, dan unsur kebahasaan 

berupa teks deskriptif lisan dan tulis 

dengan memberi dan meminta 

infromasi terkait dengan deskripsi 

orang, binatang, dan benda, sangat 

pendek dan sederhana, sesuai dengan 

konteks penggunaanya. 

KD 4.7.1 Menangkap makna secara 

kontekstual terkait fungsi sosial, 

struktur teks, dan unsur kebahasaan 

teks deskriptif lisan dan tulis, sangat 

pendek dan sederhana, terkait orang, 

binatang, dan benda. 

KD 4.7.2 Menyusun teks deskriptif 

lisan dan tulis, sangat pendek dan 

sederhana, terkait orang, binatang, dan 

benda, dengan memperhatikan fungsi 

sosial, strukter teks, dan unsur 

kebahasaan, secara benar dan sesuai 

konteks.  

 

➢ TUJUAN PEMBELAJARAN 

Setelah mengikuti proses pembelajaran, peserta didik diharapkan dapat: 

- Memahami Fungsi Sosial dari mendeskripsikan, mengidentifikasi, 

mengkritisi, memberikan penilaian tentang orang, binatang, dan benda dari 

segi sifatnya. 

- Mengidentifikasi sifat seseorang (kind, nice, friendly, ect) 

 

Media Pembelajaran, Sumber Belajar & Metode Pembelajaran 

Media  

Alat/Bahan 

Sumber Belajar 

 

Metode Pembelajaran 

Lembar Penilaian 

Spido, Papan Tulis & Laptop 

Buku Penunjang Kurikulum 2013 Mata Pelajaran 

Bahasa Inggris 

Storytelling Method 
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➢ KEGIATAN PEMBELAJARAN 

Pertemuan ke-4 

Pendahuluan 10 menit 

• Melakukan pembukaan dengan salam pembuka dan berdoa untuk memulai 

pembelajaran 

• Menanyakan kabar, mengecek kehadiran, dan mengapresiasi kehadiran siswa 

sebagai sikap disiplin 

• Menyampaikan motivasi tentang apa yang dapat diperoleh (tujuan & 

manfaat) dengan mempelajari materi : Teks Deskripsi  

• Menjelaskan hal-hal yang akan dipelajari, kompetensi yang akan dicapai, 

serta metode belajar yang akan ditempuh 

Kegiatan Inti 70 Menit 

Eksplorasi 

• Memberikan stimulus berupa pemberian materi mengenai Tesk Deskrisi 

• Mendiskusikan materi bersama siswa (Buku LKS : Bahan ajar Bahasa Inggris 

mengenai pertanyaan apa itu teks deskripsi 

• Siswa menyimak materi yang disampaikan oleh guru  

• Siswa diminta membahas contoh teks deskripsi dalam buku LKS : Bahan ajar 

Bahasa Inggris mengenai Deskripsi 

Kolaborasi 

• Membiasakan siswa membuat teks yang mendeskripsikan orang, binatang, 

atau benda. 

• Memfasilitasi siswa melalui pemberian tugas mengerjakan latihan yang 

dikerjakan secara mandiri 

• Guru memberikan perintah kepada siswa bercerita tentang hasil belajar siswa 

Konfirmasi 

• Memberikan umpan balik pada siswa dengan memberi penguatan dalam 

bentuk lisan pada siswa yang telah menyelesaikan tugasnya 

• Memfasilitasi siswa melakukan refleksi untuk memperoleh pengalaman 

belajar yang sudah dilakukan 

• Siswa diminta membuat rangkuman secara mandiri mengenai materi Teks 

Deskripsi 

Kegiatan Akhir 10 Menit 

• Guru dan siswa melakukan tanya jawab tentang materi yang telah dipelajari 

untuk mengetahui hasil ketercapaian siswa 

• Memberikan motivasi kepada siswa yang kurang dan belum bisa megikuti 

materi mengenai Teks Deskripsi 

• Mengucapkan salam dan menyampaikan rencana pembelajaran pada 

pertemuan berikutnya 
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➢ PENILAIAN HASIL PEMBELAJARAN 

- Penilaian Pengetahuan; berupa test tertulis uraian, test lisan, observasi 

terhadap diskusi tanya jawab serta penguaaan materi 

- Penilaian Keterampilan; berupa peniliaian unjuk kerja, penilaian proyek, 

penilaian produk dan penilaian portofolio 
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APPENDICES 2 

Lesson Plan of Control Group 

RENCANA PELAKSANAAN PEMBELAJARAN (RPP) 

Kelas Kontrol 

Sekolah  : MTs N 06 Boyolali   Kelas  : VIII C 

Mata Pelajaran: Bahasa Inggris   Alokasi Waktu : 2 x 45 Menit 

KD 3.7 Membandingkan fungsi sosial, 

struktur teks, dan unsur kebahasaan 

berupa teks deskriptif lisan dan tulis 

dengan memberi dan meminta 

infromasi terkait dengan deskripsi 

orang, binatang, dan benda, sangat 

pendek dan sederhana, sesuai dengan 

konteks penggunaanya. 

KD 4.7.1 Menangkap makna secara 

kontekstual terkait fungsi sosial, 

struktur teks, dan unsur kebahasaan 

teks deskriptif lisan dan tulis, sangat 

pendek dan sederhana, terkait orang, 

binatang, dan benda. 

KD 4.7.2 Menyusun teks deskriptif 

lisan dan tulis, sangat pendek dan 

sederhana, terkait orang, binatang, dan 

benda, dengan memperhatikan fungsi 

sosial, strukter teks, dan unsur 

kebahasaan, secara benar dan sesuai 

konteks.  

 

➢ TUJUAN PEMBELAJARAN 

Setelah mengikuti proses pembelajaran, peserta didik diharapkan dapat: 

- Memahami Fungsi Sosial dari mendeskripsikan, mengidentifikasi, 

mengkritisi, memberikan penilaian tentang orang, binatang, dan benda dari 

segi sifatnya. 

- Mengidentifikasi sifat seseorang (kind, nice, friendly, ect) 

 

Media Pembelajaran, Sumber Belajar & Metode Pembelajaran 

Media  

Alat/Bahan 

Sumber Belajar 

 

Metode Pembelajaran 

Lembar Penilaian 

Spido, Papan Tulis & Laptop 

Buku Penunjang Kurikulum 2013 Mata Pelajaran 

Bahasa Inggris 

Repoting Method 
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➢ KEGIATAN PEMBELAJARAN 

Pertemuan ke-1 

Pendahuluan 10 menit 

• Melakukan pembukaan dengan salam pembuka dan berdoa untuk memulai 

pembelajaran, memeriksa kehadiran siswa sebagai sikap disiplin 

• Mengaitkan materi/tema/kegiatan pembelajaran yang akan dilakukan dengan 

siswa dengan materi/tema/kegiatan sebelumnya serta mengajukan pertanyaan 

untuk mengingat dan menghubungkan dengan materi selanjutnya 

• Menyampaikan motivasi tentang apa yang dapat diperoleh (tujuan & 

manfaat) dengan mempelajari materi : Teks Deskripsi  

• Menjelaskan hal-hal yang akan dipelajari, kompetensi yang akan dicapai, 

serta metode belajar yang akan ditempuh 

Kegiatan Inti 70 Menit 

Present the new material 

• Guru menjelaskan konsep atau keterampilan dari materi teks deskripsi.   

• Siswa diminta untuk melihat, mengamati, membaca dan menulis kembali apa 

yang telah diperoleh.   

Structure Practice 

• Membiasakan siswa membuat teks berdasarkan yang telah diamati 

• Memfasilitasi siswa melalui pemberian tugas mengerjakan latihan yang 

dikerjakan secara mandiri 

• Membiasakan siswa untuk mempresentasikan hasil yang telah diamati 

Konfirmasi 

• Memberikan umpan balik pada siswa dengan memberi penguatan dalam 

bentuk lisan pada siswa yang telah menyelesaikan tugasnya 

• Siswa diminta membuat rangkuman secara mandiri mengenai materi Teks 

Deskripsi 

Kegiatan Akhir 10 Menit 

• Guru memberikan latihan mandiri kepada siswa 

• Memberikan motivasi kepada siswa yang kurang dan belum bisa megikuti 

materi mengenai Teks Deskripsi 

• Mengucapkan salam dan menyampaikan rencana pembelajaran pada 

pertemuan berikutnya 
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➢ PENILAIAN HASIL PEMBELAJARAN 

- Penilaian Pengetahuan; berupa test tertulis uraian, test lisan, observasi 

terhadap diskusi tanya jawab serta penguaaan materi 

- Penilaian Keterampilan; berupa peniliaian unjuk kerja, penilaian proyek, 

penilaian produk dan penilaian portofolio 
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RENCANA PELAKSANAAN PEMBELAJARAN (RPP) 

Kelas Kontrol 

Sekolah : MTs N 06 Boyolali   Kelas  : VIII C 

Mata Pelajaran: Bahasa Inggris   Alokasi Waktu : 2 x 45 Menit 

KD 3.7 Membandingkan fungsi sosial, 

struktur teks, dan unsur kebahasaan 

berupa teks deskriptif lisan dan tulis 

dengan memberi dan meminta 

infromasi terkait dengan deskripsi 

orang, binatang, dan benda, sangat 

pendek dan sederhana, sesuai dengan 

konteks penggunaanya. 

KD 4.7.1 Menangkap makna secara 

kontekstual terkait fungsi sosial, 

struktur teks, dan unsur kebahasaan 

teks deskriptif lisan dan tulis, sangat 

pendek dan sederhana, terkait orang, 

binatang, dan benda. 

KD 4.7.2 Menyusun teks deskriptif 

lisan dan tulis, sangat pendek dan 

sederhana, terkait orang, binatang, dan 

benda, dengan memperhatikan fungsi 

sosial, strukter teks, dan unsur 

kebahasaan, secara benar dan sesuai 

konteks.  

 

➢ TUJUAN PEMBELAJARAN 

Setelah mengikuti proses pembelajaran, peserta didik diharapkan dapat: 

- Memahami Fungsi Sosial dari mendeskripsikan, mengidentifikasi, 

mengkritisi, memberikan penilaian tentang orang, binatang, dan benda dari 

segi sifatnya. 

- Mengidentifikasi sifat seseorang (kind, nice, friendly, ect) 

 

Media Pembelajaran, Sumber Belajar & Metode Pembelajaran 

Media  

Alat/Bahan 

Sumber Belajar 

 

Metode Pembelajaran 

Lembar Penilaian 

Spido, Papan Tulis & Laptop 

Buku Penunjang Kurikulum 2013 Mata Pelajaran 

Bahasa Inggris 

Repoting Method 

 

 

 

 



108 

 

 

➢ KEGIATAN PEMBELAJARAN 

Pertemuan ke-2 

Pendahuluan 10 menit 

• Melakukan pembukaan dengan salam pembuka dan berdoa untuk memulai 

pembelajaran, memeriksa kehadiran siswa sebagai sikap disiplin 

• Mengaitkan materi/tema/kegiatan pembelajaran yang akan dilakukan dengan 

siswa dengan materi/tema/kegiatan sebelumnya serta mengajukan pertanyaan 

untuk mengingat dan menghubungkan dengan materi selanjutnya 

• Menyampaikan motivasi tentang apa yang dapat diperoleh (tujuan & 

manfaat) dengan mempelajari materi : Teks Deskripsi  

• Menjelaskan hal-hal yang akan dipelajari, kompetensi yang akan dicapai, 

serta metode belajar yang akan ditempuh 

Kegiatan Inti 70 Menit 

Present the new material 

• Guru menjelaskan konsep atau keterampilan dari materi teks deskripsi.   

• Siswa diminta untuk melihat, mengamati, membaca dan menulis kembali apa 

yang telah diperoleh.   

Structure Practice 

• Membiasakan siswa membuat teks berdasarkan yang telah diamati 

• Memfasilitasi siswa melalui pemberian tugas mengerjakan latihan yang 

dikerjakan secara mandiri 

• Membiasakan siswa untuk mempresentasikan hasil yang telah diamati 

Konfirmasi 

• Memberikan umpan balik pada siswa dengan memberi penguatan dalam 

bentuk lisan pada siswa yang telah menyelesaikan tugasnya 

• Siswa diminta membuat rangkuman secara mandiri mengenai materi Teks 

Deskripsi 

Kegiatan Akhir 10 Menit 

• Guru memberikan latihan mandiri kepada siswa 

• Memberikan motivasi kepada siswa yang kurang dan belum bisa megikuti 

materi mengenai Teks Deskripsi 

• Mengucapkan salam dan menyampaikan rencana pembelajaran pada 

pertemuan berikutnya 
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➢ PENILAIAN HASIL PEMBELAJARAN 

- Penilaian Pengetahuan; berupa test tertulis uraian, test lisan, observasi 

terhadap diskusi tanya jawab serta penguaaan materi 

- Penilaian Keterampilan; berupa peniliaian unjuk kerja, penilaian proyek, 

penilaian produk dan penilaian portofolio 

 

 

 

Boyolali, 12 Januari 2024 

 

Mengetahui 

Guru Bahasa Inggris MTs N 06 Boyolali  Mahasiswa 

 

 

 

 

 

___________________________  Rosalia Mega Artikarini 

NIP.      NIM. 206121243 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



110 

 

 

RENCANA PELAKSANAAN PEMBELAJARAN (RPP) 

Kelas Kontrol 

Sekolah  : MTs N 06 Boyolali   Kelas  : VIII C 

Mata Pelajaran: Bahasa Inggris   Alokasi Waktu : 2 x 45 Menit 

KD 3.7 Membandingkan fungsi sosial, 

struktur teks, dan unsur kebahasaan 

berupa teks deskriptif lisan dan tulis 

dengan memberi dan meminta 

infromasi terkait dengan deskripsi 

orang, binatang, dan benda, sangat 

pendek dan sederhana, sesuai dengan 

konteks penggunaanya. 

KD 4.7.1 Menangkap makna secara 

kontekstual terkait fungsi sosial, 

struktur teks, dan unsur kebahasaan 

teks deskriptif lisan dan tulis, sangat 

pendek dan sederhana, terkait orang, 

binatang, dan benda. 

KD 4.7.2 Menyusun teks deskriptif 

lisan dan tulis, sangat pendek dan 

sederhana, terkait orang, binatang, dan 

benda, dengan memperhatikan fungsi 

sosial, strukter teks, dan unsur 

kebahasaan, secara benar dan sesuai 

konteks.  

 

➢ TUJUAN PEMBELAJARAN 

Setelah mengikuti proses pembelajaran, peserta didik diharapkan dapat: 

- Memahami Fungsi Sosial dari mendeskripsikan, mengidentifikasi, 

mengkritisi, memberikan penilaian tentang orang, binatang, dan benda dari 

segi sifatnya. 

- Mengidentifikasi sifat seseorang (kind, nice, friendly, ect) 

 

Media Pembelajaran, Sumber Belajar & Metode Pembelajaran 

Media  

Alat/Bahan 

Sumber Belajar 

 

Metode Pembelajaran 

Lembar Penilaian 

Spido, Papan Tulis & Laptop 

Buku Penunjang Kurikulum 2013 Mata Pelajaran 

Bahasa Inggris 

Repoting Method 
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➢ KEGIATAN PEMBELAJARAN 

Pertemuan ke-3 

Pendahuluan 10 menit 

• Melakukan pembukaan dengan salam pembuka dan berdoa untuk memulai 

pembelajaran, memeriksa kehadiran siswa sebagai sikap disiplin 

• Mengaitkan materi/tema/kegiatan pembelajaran yang akan dilakukan dengan 

siswa dengan materi/tema/kegiatan sebelumnya serta mengajukan pertanyaan 

untuk mengingat dan menghubungkan dengan materi selanjutnya 

• Menyampaikan motivasi tentang apa yang dapat diperoleh (tujuan & 

manfaat) dengan mempelajari materi : Teks Deskripsi  

• Menjelaskan hal-hal yang akan dipelajari, kompetensi yang akan dicapai, 

serta metode belajar yang akan ditempuh 

Kegiatan Inti 70 Menit 

Present the new material 

• Guru menjelaskan konsep atau keterampilan dari materi teks deskripsi.   

• Siswa diminta untuk melihat, mengamati, membaca dan menulis kembali apa 

yang telah diperoleh.   

Structure Practice 

• Membiasakan siswa membuat teks berdasarkan yang telah diamati 

• Memfasilitasi siswa melalui pemberian tugas mengerjakan latihan yang 

dikerjakan secara mandiri 

• Membiasakan siswa untuk mempresentasikan hasil yang telah diamati 

Konfirmasi 

• Memberikan umpan balik pada siswa dengan memberi penguatan dalam 

bentuk lisan pada siswa yang telah menyelesaikan tugasnya 

• Siswa diminta membuat rangkuman secara mandiri mengenai materi Teks 

Deskripsi 

Kegiatan Akhir 10 Menit 

• Guru memberikan latihan mandiri kepada siswa 

• Memberikan motivasi kepada siswa yang kurang dan belum bisa megikuti 

materi mengenai Teks Deskripsi 

• Mengucapkan salam dan menyampaikan rencana pembelajaran pada 

pertemuan berikutnya 
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➢ PENILAIAN HASIL PEMBELAJARAN 

- Penilaian Pengetahuan; berupa test tertulis uraian, test lisan, observasi 

terhadap diskusi tanya jawab serta penguaaan materi 

- Penilaian Keterampilan; berupa peniliaian unjuk kerja, penilaian proyek, 

penilaian produk dan penilaian portofolio 
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RENCANA PELAKSANAAN PEMBELAJARAN (RPP) 

Kelas Kontrol 

Sekolah  : MTs N 06 Boyolali   Kelas  : VIII C 

Mata Pelajaran: Bahasa Inggris   Alokasi Waktu : 2 x 45 Menit 

KD 3.7 Membandingkan fungsi sosial, 

struktur teks, dan unsur kebahasaan 

berupa teks deskriptif lisan dan tulis 

dengan memberi dan meminta 

infromasi terkait dengan deskripsi 

orang, binatang, dan benda, sangat 

pendek dan sederhana, sesuai dengan 

konteks penggunaanya. 

KD 4.7.1 Menangkap makna secara 

kontekstual terkait fungsi sosial, 

struktur teks, dan unsur kebahasaan 

teks deskriptif lisan dan tulis, sangat 

pendek dan sederhana, terkait orang, 

binatang, dan benda. 

KD 4.7.2 Menyusun teks deskriptif 

lisan dan tulis, sangat pendek dan 

sederhana, terkait orang, binatang, dan 

benda, dengan memperhatikan fungsi 

sosial, strukter teks, dan unsur 

kebahasaan, secara benar dan sesuai 

konteks.  

 

➢ TUJUAN PEMBELAJARAN 

Setelah mengikuti proses pembelajaran, peserta didik diharapkan dapat: 

- Memahami Fungsi Sosial dari mendeskripsikan, mengidentifikasi, 

mengkritisi, memberikan penilaian tentang orang, binatang, dan benda dari 

segi sifatnya. 

- Mengidentifikasi sifat seseorang (kind, nice, friendly, ect) 

 

Media Pembelajaran, Sumber Belajar & Metode Pembelajaran 

Media  

Alat/Bahan 

Sumber Belajar 

 

Metode Pembelajaran 

Lembar Penilaian 

Spido, Papan Tulis & Laptop 

Buku Penunjang Kurikulum 2013 Mata Pelajaran 

Bahasa Inggris 

Repoting Method 
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➢ KEGIATAN PEMBELAJARAN 

Pertemuan ke-4 

Pendahuluan 10 menit 

• Melakukan pembukaan dengan salam pembuka dan berdoa untuk memulai 

pembelajaran, memeriksa kehadiran siswa sebagai sikap disiplin 

• Mengaitkan materi/tema/kegiatan pembelajaran yang akan dilakukan dengan 

siswa dengan materi/tema/kegiatan sebelumnya serta mengajukan pertanyaan 

untuk mengingat dan menghubungkan dengan materi selanjutnya 

• Menyampaikan motivasi tentang apa yang dapat diperoleh (tujuan & 

manfaat) dengan mempelajari materi : Teks Deskripsi  

• Menjelaskan hal-hal yang akan dipelajari, kompetensi yang akan dicapai, 

serta metode belajar yang akan ditempuh 

Kegiatan Inti 70 Menit 

Present the new material 

• Guru menjelaskan konsep atau keterampilan dari materi teks deskripsi.   

• Siswa diminta untuk melihat, mengamati, membaca dan menulis kembali apa 

yang telah diperoleh.   

Structure Practice 

• Membiasakan siswa membuat teks berdasarkan yang telah diamati 

• Memfasilitasi siswa melalui pemberian tugas mengerjakan latihan yang 

dikerjakan secara mandiri 

• Membiasakan siswa untuk mempresentasikan hasil yang telah diamati 

Konfirmasi 

• Memberikan umpan balik pada siswa dengan memberi penguatan dalam 

bentuk lisan pada siswa yang telah menyelesaikan tugasnya 

• Siswa diminta membuat rangkuman secara mandiri mengenai materi Teks 

Deskripsi 

Kegiatan Akhir 10 Menit 

• Guru memberikan latihan mandiri kepada siswa 

• Memberikan motivasi kepada siswa yang kurang dan belum bisa megikuti 

materi mengenai Teks Deskripsi 

• Mengucapkan salam dan menyampaikan rencana pembelajaran pada 

pertemuan berikutnya 
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➢ PENILAIAN HASIL PEMBELAJARAN 

- Penilaian Pengetahuan; berupa test tertulis uraian, test lisan, observasi 

terhadap diskusi tanya jawab serta penguaaan materi 

- Penilaian Keterampilan; berupa peniliaian unjuk kerja, penilaian proyek, 

penilaian produk dan penilaian portofolio 

 

 

 

Boyolali, 12 Januari 2024 

 

Mengetahui 

Guru Bahasa Inggris MTs N 06 Boyolali  Mahasiswa 

 

 

 

 

 

___________________________  Rosalia Mega Artikarini 

NIP.      NIM. 206121243 
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APPENDICES 3 

Students List of Experimental Group 

NO NAME L/P 

1 Almira Jamine Budiyono P 

2 Anindita Natacila P 

3 Arthalia Septiana Putri P 

4 Aya Icha Fauzia P 

5 Bara Azzahran L 

6 Bryan Nara Wasesa L 

7 Cinta Oktaviana Adelita Jelita P 

8 Diyah Aulia Falasari P 

9 Fahri Albiano Setyawan L 

10 Fala Kirana Nindia Putri Endarto P 

11 Fauzi Wasta Pratama L 

12 Faza Fadika Ramadhan L 

13 Huaquincito L 

14 Izza Anugerah Putra L 

15 Jingga Karunia Putri P 

16 Johan Pramudita L 

17 Khaila Syafa Nadya P 

18 Khalisha Ayyasy Azhar P 

19 Kirana Dwi Aura Putri P 

20 Muhammad Ega Pratama L 

21 Naima Rizqi Khoirawati P 

22 Naovan Detta Fahzera L 

23 Nesya Aprilia P 

24 Rafa Febrian Pratama L 

25 Rayhana Nayswa Putri P 

26 Saif Maulana Irwansyah L 

27 Seila Sabilah Rohmah P 

28 Sifa Fitria Ramadhani P 

29 Slaffani Az Zahra P 

30 Sultan Mustofa L 

31 Ulinuha Fatmawati P 

32 Vinno Dewasila L 
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APPENDICES 4 

Students List of Control Group 

NO NAME L/P 

1 Alfira Nabil Mufiidah P 

2 Alifah Kusnaeni P 

3 Alvin Nauval Al Hafizh L 

4 Anugerah Akbar Musyafa L 

5 Arina Sheila Maharani P 

6 Arshiva Ulul Azmi P 

7 Askana Sakhi Ratifah Firdaus P 

8 Ayzerga Barnes Wibowo L 

9 Azam Fathkan Dani Abdurrahman L 

10 Bilqis Wardatul Hisan P 

11 Choirul Mustofa L 

12 Cika Octavia Nurcahyani P 

13 Clarissa Azalia Farida P 

14 Didik Karyadi L 

15 Fahri Rahman L 

16 Fina Alfian P 

17 Inafakhul Khoirunnisa P 

18 Jihan Nuha Tafidah P 

19 Ken Mad Chandragupita Widyatamaka L 

20 Lia Novitasari P 

21 Lintang Kanaya Setya Nareswari P 

22 Muh Satria Nur Wafa L 

23 Muhammad Fadil Saputra L 

24 Muhammad Rehan Mustofa L 

25 Nabila Zahiyah Insari P 

26 Nadiya Liviana Sari P 

27 Natasya Paramita Nungrum P 

28 Nesar Yasmin Aurelya P 

29 Said Abdurrahman Al Hanif L 

30 Sultan Nur Anshori L 

31 Tsamara Qurrota Aini Fauziyah P 

32 Waiz Nur Ikhsan L 
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APPENDICES 5 

Pre-test  

PRE-TEST 

TAHUN PELAJARAN 2023/2024 

MTs N 06 BOYOLALI 

KURIKULUM 2013 

LEMBAR INTRUKSI 

 

Mata Pelajaran  : Bahasa Inggris 

Kelas    : VIII A/C 

Hari/tanggal   : Jum’at, 05 Januari 2024 

Waktu               : 07.30-09.30 (120 Menit) 

 

The instruction for the speaking test is : 

1. The researcher provider instruction to students with the topics that have 

prepared. 

2. Students come to the front of the class individually. 

3. Students explain according to the topic provided about yourself. 

4. The researcher assesses students abilities according to the indicators used. 
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APPENDICES 6 

Post-test 

POST-TEST 

TAHUN PELAJARAN 2023/2024 

MTs N 06 BOYOLALI 

KURIKULUM 2013 

LEMBAR INTRUKSI 

 

Mata Pelajaran  : Bahasa Inggris 

Kelas    : VIII A/C 

Hari/tanggal   : Senin, 29 Januari 2024 

Waktu               : 07.30-09.30 (120 Menit) 

 

The instruction for the speaking test is : 

1. The researcher provider instruction to students with the topics that have 

prepared. 

2. Students come to the front of the class individually. 

3. Students explain according to the topic provided about you own preferences. 

4. The researcher assesses students abilities according to the indicators used. 
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APPENDICES 7 

Pre-test Score of Experimental Group 

No NAME STUDENT SCORE 

PRE-TEST Mean Of 

Interater T-Score R-Score 

1 Almira Jamine Budiyono 65 65 65 

2 Anindita Natacila 75 65 70 

3 Arthalia Septiana Putri 80 70 75 

4 Aya Icha Fauzia 70 60 65 

5 Bara Azzahran 60 50 55 

6 Bryan Nara Wasesa 65 75 70 

7 Cinta Oktaviana Adelita Jelita 70 60 65 

8 Diyah Aulia Falasari 55 65 60 

9 Fahri Albiano Setyawan 50 60 55 

10 Fala Kirana Nindia Putri Endarto 70 80 75 

11 Fauzi Wasta Pratama 60 70 65 

12 Faza Fadika Ramadhan 55 65 60 

13 Huaquincito 70 60 65 

14 Izza Anugerah Putra 80 70 75 

15 Jingga Karunia Putri 70 60 65 

16 Johan Pramudita 75 65 70 

17 Khaila Syafa Nadya 70 60 65 

18 Khalisha Ayyasy Azhar 80 70 75 

19 Kirana Dwi Aura Putri 70 60 65 

20 Muhammad Ega Pratama 50 60 55 

21 Naima Rizqi Khoirawati 60 70 65 

22 Naovan Detta Fahzera 65 55 60 

23 Nesya Aprilia 75 65 70 

24 Rafa Febrian Pratama 60 70 65 

25 Rayhana Nayswa Putri 50 60 55 

26 Saif Maulana Irwansyah 65 55 60 

27 Seila Sabilah Rohmah 50 60 55 

28 Sifa Fitria Ramadhani 80 70 75 

29 Slaffani Az Zahra 70 80 75 

30 Sultan Mustofa 65 75 70 

31 Ulinuha Fatmawati 75 65 70 

32 Vinno Dewasila 70 80 75 
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APPENDICES 8 

Pre-test of Control Group 

No NAME STUDENT SCORE 

PRE-TEST Mean Of 

Interater T-Score R-Score 

1 Alfira Nabil Mufiidah 75 65 70 

2 Alifah Kusnaeni 55 65 60 

3 Alvin Nauval Al Hafizh 60 50 55 

4 Anugerah Akbar Musyafa 65 55 60 

5 Arina Sheila Maharani 70 60 65 

6 Arshiva Ulul Azmi 55 65 60 

7 Askana Sakhi Ratifah Firdaus 50 60 55 

8 Ayzerga Barnes Wibowo 65 55 60 

9 Azam Fathkan Dani Abdurrahman 60 70 65 

10 Bilqis Wardatul Hisan 75 65 70 

11 Choirul Mustofa 60 70 65 

12 Cika Octavia Nurcahyani 55 65 60 

13 Clarissa Azalia Farida 60 50 55 

14 Didik Karyadi 55 65 60 

15 Fahri Rahman 65 55 60 

16 Fina Alfian 50 60 55 

17 Inafakhul Khoirunnisa 55 65 60 

18 Jihan Nuha Tafidah 70 60 65 

19 Ken Mad Chandragupita Widyatamaka 65 55 60 

20 Lia Novitasari 60 70 65 

21 Lintang Kanaya Setya Nareswari 80 70 75 

22 Muh Satria Nur Wafa 60 50 55 

23 Muhammad Fadil Saputra 55 65 60 

24 Muhammad Rehan Mustofa 50 60 55 

25 Nabila Zahiyah Insari 60 70 65 

26 Nadiya Liviana Sari 75 65 70 

27 Natasya Paramita Nungrum 65 55 60 

28 Nesar Yasmin Aurelya 70 60 65 

29 Said Abdurrahman Al Hanif 65 75 70 

30 Sultan Nur Anshori 55 65 60 

31 Tsamara Qurrota Aini Fauziyah 70 80 75 

32 Waiz Nur Ikhsan 50 60 55 
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APPENDICES 9 

Post-test of Experimental Group  

No NAME STUDENT SCORE 

POST-TEST Mean Of 

Interater T-Score R-Score 

1 Almira Jamine Budiyono 80 70 75 

2 Anindita Natacila 70 80 75 

3 Arthalia Septiana Putri 90 80 85 

4 Aya Icha Fauzia 75 65 70 

5 Bara Azzahran 85 75 80 

6 Bryan Nara Wasesa 80 90 85 

7 Cinta Oktaviana Adelita Jelita 65 75 70 

8 Diyah Aulia Falasari 70 80 75 

9 Fahri Albiano Setyawan 70 60 65 

10 Fala Kirana Nindia Putri Endarto 85 75 80 

11 Fauzi Wasta Pratama 95 85 90 

12 Faza Fadika Ramadhan 75 65 70 

13 Huaquincito 70 70 75 

14 Izza Anugerah Putra 85 95 90 

15 Jingga Karunia Putri 90 80 85 

16 Johan Pramudita 65 75 70 

17 Khaila Syafa Nadya 70 80 75 

18 Khalisha Ayyasy Azhar 80 90 85 

19 Kirana Dwi Aura Putri 70 80 75 

20 Muhammad Ega Pratama 60 70 65 

21 Naima Rizqi Khoirawati 75 85 80 

22 Naovan Detta Fahzera 75 65 70 

23 Nesya Aprilia 80 70 75 

24 Rafa Febrian Pratama 85 75 80 

25 Rayhana Nayswa Putri 80 70 75 

26 Saif Maulana Irwansyah 75 85 80 

27 Seila Sabilah Rohmah 80 90 85 

28 Sifa Fitria Ramadhani 85 75 80 

29 Slaffani Az Zahra 95 85 90 

30 Sultan Mustofa 75 85 80 

31 Ulinuha Fatmawati 65 75 70 

32 Vinno Dewasila 75 85 80 
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APPENDICES 10 

Post-test of Control Group 

No NAME STUDENT SCORE 

POST-TEST Mean Of 

Interater T-Score R-Score 

1 Alfira Nabil Mufiidah 65 75 70 

2 Alifah Kusnaeni 75 65 70 

3 Alvin Nauval Al Hafizh 60 70 65 

4 Anugerah Akbar Musyafa 75 85 80 

5 Arina Sheila Maharani 80 70 75 

6 Arshiva Ulul Azmi 75 85 80 

7 Askana Sakhi Ratifah Firdaus 70 60 65 

8 Ayzerga Barnes Wibowo 85 75 80 

9 Azam Fathkan Dani Abdurrahman 70 80 75 

10 Bilqis Wardatul Hisan 90 80 85 

11 Choirul Mustofa 75 85 80 

12 Cika Octavia Nurcahyani 80 70 75 

13 Clarissa Azalia Farida 65 75 70 

14 Didik Karyadi 85 75 80 

15 Fahri Rahman 70 80 75 

16 Fina Alfian 60 70 65 

17 Inafakhul Khoirunnisa 80 70 75 

18 Jihan Nuha Tafidah 75 65 70 

19 Ken Mad Chandragupita Widyatamaka 75 85 80 

20 Lia Novitasari 70 80 75 

21 Lintang Kanaya Setya Nareswari 80 90 90 

22 Muh Satria Nur Wafa 75 65 70 

23 Muhammad Fadil Saputra 80 70 75 

24 Muhammad Rehan Mustofa 70 60 65 

25 Nabila Zahiyah Insari 80 90 85 

26 Nadiya Liviana Sari 70 80 75 

27 Natasya Paramita Nungrum 85 75 80 

28 Nesar Yasmin Aurelya 75 65 70 

29 Said Abdurrahman Al Hanif 75 85 80 

30 Sultan Nur Anshori 70 80 75 

31 Tsamara Qurrota Aini Fauziyah 85 95 90 

32 Waiz Nur Ikhsan 75 65 70 
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APPENDICES 11 

Readability 
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APPENDICES 12 

Video Speaking Students of  

Experimental and Control Groups  

https://drive.google.com/drive/folders/1-6OvBrb2uNVdOXaMJQRhoB6VAi-

4PMrO  
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APPENDICES 13 

Photographs test of Speaking 
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APPENDICES 14 

Photographs 
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APPENDICES 15 

Permission Letter to Complete the Research 

 


